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Legal Notes
Unauthorized reproduction of all or part of this guide is prohibited.
The information in this guide is subject to change for improvement without notice.
We cannot be held liable for any problems arising from the use of this product, regardless of the information herein.

Regarding Trademarks
Microsoft Windows is a registered trademark of Microsoft Corporation in the U.S. and/or other countries. KPDL is a
trademark of Kyocera Corporation. PCL is a trademark of Hewlett-Packard Company. TrueType is a registered trademark
of Apple Computer, Inc.
All other brand and product names herein are registered trademarks or trademarks of their respective companies
Examples of the operations given in this guide support the Windows XP printing environment. Essentially the same
operations are used for Microsoft Windows Vista, Windows Server 2008 and Windows 2000 environments.
User Interface screen captures shown in this guide may differ depending on your printing device.
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1 Installation

A printer driver is an application that manages communication between a printer
and your computer. Once installed, the printer driver settings must be
configured in the printer Properties and Printing Preferences.
These options are available during the Installation process:
Express Installation on page 1-2
Custom Installation on page 1-4
Installing Optional Printer Components on page 1-7
The Add Printer Wizard on page 1-7
Changing the Default Driver Settings on page 1-8

Note: In Windows Vista, Windows XP, and Windows 2000, you must be
logged in with administrator rights to install the printer driver. If you connect a
USB (Universal Serial Bus) cable before printer driver installation, it is strongly
recommended that you cancel the Found New Hardware Wizard and install the
software through the Product Library CD menu. Browsing the CD and
installing each driver separately is not recommended.

Preparing to Install the Driver
This section describes the initial steps to take before you install the printer
driver, and based on your operating system, the next procedure you can follow.

1 Turn on the computer and the printer. If you have a USB connection, the
Windows Found New Hardware Wizard dialog box appears. Click Cancel.

2 Insert the Product Library CD into the CD drive.

After the installation wizard begins, the Main Menu appears.

Note: If the Product Library fails to start after inserting the Product Library
CD into the CD drive, use Windows Explorer to locate Setup.exe on the local
drive and double-click to open.

3 Click View License Agreement to read the license agreement.

4 Click Accept to proceed.

5 To begin the installation, click Install Software.

Note: If the Windows Security warning dialog box appears at any point
during the installation process, click Install this driver software anyway.

6 The Installer wizard appears. Click Next.
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The installation differs based on your operating system and connection method.
Select your operating system and connection method from the following list and
proceed to the reference page to continue the installation.
Express Installation
Installing on Windows Vista and Windows XP on page 1-2
Custom Installation
Installing on Windows Vista and Windows XP with a USB Connection on page
1-4
Installing on Windows Vista and Windows XP with a Network Connection on
page 1-5

Note: Port Set Up installs a client port monitor that provides Windows
TCP/IP printing to any network card connected to a printing system. Port Set
Up supports LPR and IPP printing. For the Port Set Up Guide instructions,
refer to your CD. Port Set Up uses a stand-alone installer.

Installing Utilities
On the Installation Method screen, click Utilities to install printer utilities. You
can also select utilities to install during the Custom Installation procedure.

Upgrading Driver Components
If the installation wizard detects older driver or utility components, the Software
Component Upgrade page appears.

1 Choose the component to upgrade. Click Next.

2 Confirm your upgrade settings. To start the upgrade, click Upgrade.

3 When the upgrade completes, click Next. The Installation Method page
appears.

Express Installation
Express Mode applies to driver installation for a USB or network connection
only. The installation wizard discovers printers that are turned on, and
connected by USB and network cable. In Custom Mode, you are able to select
the installation packages and specify the port.

Installing on Windows Vista and Windows XP
This section describes the express installation procedure of the driver software
on Windows Vista and Windows XP.

1 Ensure that your printer and computer are turned on and connected by USB or
network cable.

Note: If the Found New Hardware Wizard dialog box appears during the
installation process, click Cancel. If the Hardware Installation warning dialog
box appears, click Continue Anyway.
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2 On the Installation Method page, click Express Mode.

3 The Discover Printing System page opens to search for your printer. If
Discover does not find your printing system, a message appears. Remove and
reinsert the USB or network cable, and ensure it is connected properly. Click
Refresh to retry the discovery. If the system still cannot find your printer, contact
your system administrator.
If Discovery finds your printer, click the printer name to select it.

4 Select Use host name for port name to use a host name for the Standard
TCP/IP port. If the installation wizard still displays the IP address, contact your
system administrator. (Not available with a USB connection.)

5 Click Information if you want to open a dialog box with details about IP
Address, Host Name, Printer Model, Contact, Location, and Serial Number.
Click OK. Click Next. (Not available with a USB connection.)

6 On the Printer Settings page, you can assign a name to the printing system.

You can also choose to share this printer with others or set this printer as the
default printer. Make your selections, and then click Next.

7 On the Confirm Settings page, click Install if the settings are correct. Click
Back to correct the settings.

8 The Installation Completed page appears displaying the following driver
options.

Print a test page
This selection verifies a connection with the printer and creates a print out of
the installed driver components.
Show Quick Print Tab
This selection lets you define basic print options into group profiles that can
be accessed easily. The Show Quick Print tab option also appears in the
Administrator Settings in the Device Settings tab.
Enable Status Monitor
The Status Monitor displays system status messages on your computer
screen during printing tasks. The Status Monitor button appears on the
Advanced tab.
Device Settings
Select Device Settings to open the Device Settings tab where you can
choose installed options for your printing system. (In Windows Vista, or with
a USB connection, the Device Settings check box is not displayed).

When the installation completes successfully, click Finish to exit the installation
wizard and return to the Product Library CD menu.
Software installation failures generate the following message:

One or more software installations have failed.

Click Finish, and retry the installation. If the same message appears again,
contact your system administrator.
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The installation of the printer is now complete. If prompted, restart your
computer.

Custom Installation
Custom Mode is an option to install utilities. You can specify the printer port,
fonts, and the utilities you want to install.
Printer drivers that ship with Windows operating systems are called minidrivers.
The minidriver is available separately for PCL and KPDL and provides basic
support for your printer. Minidriver functionality is not documented in this user
guide.

Installing on Windows Vista and Windows XP with a USB
Connection

This section describes the custom installation procedure of the driver software
on Windows Vista and Windows XP using a USB connection.

1 Ensure that your printer and computer are turned on and connected using a
USB cable.

2 On the Installation Method page, select Custom Mode.

3 The Discover Printing System page appears displaying Discover selected.
You can use this option, or the Custom select option.
With the Discover option, you can let the system find all the devices available
for driver installation. If you use this option, proceed to step 4.
With the Custom select option, you can choose the printing system and printer
port to install. Proceed to step 6.
If Discover does not find your printing system, a message appears. Ensure that
your printer is properly connected by the correct cable and is turned on, and
then close the message box. Remove and reinsert the USB cable to your
computer and retry the discovery. Contact your system administrator if the
system cannot find your printer.

4 If Discover finds one or more USB printing systems, select your model from the
list. Click Next.

5 On the Custom Installation page, select the driver and software packages you
want to install from the Driver and Utility tabs, and clear those not intended for
installation. Click Next. Proceed to step 10.

6 On the Printing System page, select your model, and then click Next.

7 On the Printer Port page, select the port connected to your printing system.
Click Next.

8 On the Custom Installation page, select the driver and software packages you
want to install from the Driver and Utility tabs, and clear those not intended for
installation. Click Next.
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9 On the Printer Settings page, you can assign a name for the printing system.
You can also choose to share this printer with others or set this printer as the
default printer. Make your selections, and then click Next.

10 On the Confirm Settings page, click Install if the settings are correct. Click
Back to correct the settings.

Note: If the Hardware Installation warning dialog box appears, click
Continue Anyway.

11 The Installation Completed page appears displaying the following driver
options.

Print a test page
This selection verifies a connection with the printer and creates a print out of
the installed driver components.
Show Quick Print Tab
This selection lets you define basic print options into group profiles that can
be accessed easily. The Show Quick Print tab option also appears in the
Administrator Settings in the Device Settings tab.
Enable Status Monitor
The Status Monitor displays system status messages on your computer
screen during printing tasks. The Status Monitor button appears on the
Advanced tab.

When the installation completes successfully, click Finish to exit the installation
wizard and return to the Product Library CD menu.
Software installation failures generate the following message:

One or more software installations have failed.

Click Finish, and retry the installation. If the same message appears again,
contact your system administrator.
The installation of the printer is now complete. If prompted, restart your
computer.

Installing on Windows Vista and Windows XP with a Network
Connection

This section describes the custom installation procedure of the driver software
on Windows Vista and Windows XP using a network connection.

1 Ensure that your printer and computer are connected to a network.

2 On the Installation Method page, select Custom Mode.

3 The Discover Printing System page appears displaying Discover selected.
For an Express Installation, you can let Discover find your printing system,
and proceed with the steps in Express Installation. Otherwise, you can choose
Custom select, and click Next to continue with a custom installation.

4 On the Printing System page, select the model, and then click Next.
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5 On the Printer Port page, select the port connected to your printing system, or
add a port connected to your system by clicking Add Port. Click Next.

6 On the Custom Installation page, select the driver and software packages you
want to install from the Driver and Utility tabs, and clear those not intended for
installation. Click Next.

7 On the Printer Settings page, you can assign a name for the printing system.
You can also choose to share this printer with others or set this printer as the
default printer. Make your selections, and then click Next.

8 On the Confirm Settings page, click Install if the settings are correct. Click
Back to correct the settings.

Note: If the Hardware Installation warning dialog box appears, click
Continue.

9 The Installation Completed page appears displaying the following driver
options.

Print a test page
This selection verifies a connection with the printer and creates a print out of
the installed driver components.
Show Quick Print Tab
This selection lets you define basic print options into group profiles that can
be accessed easily. The Show Quick Print tab option also appears in the
Administrator Settings in the Device Settings tab.
Enable Status Monitor
The Status Monitor displays system status messages on your computer
screen during printing tasks. The Status Monitor button appears on the
Advanced tab.
Device Settings
Select Device Settings to open the Device Settings tab where you can
choose installed options for your printing system. (The Device Settings
check box appears only with Windows XP.)

When the installation completes successfully, click Finish to exit the installation
wizard and return to the Product Library CD menu.
Software installation failures generate the following message:

One or more software installations have failed.

Click Finish, and retry the installation. If the same message appears again,
contact your system administrator.
The installation of the printer is now complete. If prompted, restart your
computer.

Optional Printer Components
You can expand the functionality of your printer driver by installing optional
components from the Product Library CD > Advanced Tools menu.
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Installing Optional Printer Components

1 On the Product Library CD menu, select Advanced Tools.

2 On the Advanced Tools page, select Optional Printer Components.

3 Select a printer, and click Next to install optional components.

4 On all Select pages, choose your components, and click Next.

5 On the Confirm Settings page, if the displayed settings are correct, click
Install. Click Back to correct any settings.

6 The Printer Components Installation Completed page appears. Click Finish.

When you have completed installing printers and optional components, if
prompted, restart your computer.

The Add Printer Wizard
The Add Printer Wizard displays a series of screens that guide you through
printer installation. You are prompted to make installation choices on each
screen.

Installing on Windows Vista
This section describes how to install a printer driver using the Add Printer
Wizard in Windows Vista.

1 Click the Start icon in the Windows taskbar at the bottom of the screen.

2 In the Start window, click Control Panel.

3 In the Control Panel, click Printers.

4 In the Printers window toolbar, click Add a printer.

5 The Add Printer Wizard appears. The wizard provides you with step by step
driver installation instructions. Click either Add a local printer or Add a
network, wireless or Bluetooth printer. Follow the instructions on each page,
then click Next to proceed to the next page.

Note: If the Windows Security warning dialog box appears, click Install this
driver software anyway.

6 The last page of the wizard appears with a message that you’ve successfully
added the printer you selected. Installation of the printer driver is now complete.
Click Print a test page if you want to produce sample print output from the
newly installed printer. To close the Add Printer Wizard, click Finish.
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Installing on Windows XP and Windows 2000
This section describes how to install a printer driver using the Add Printer
Wizard on Windows XP and Windows 2000.

1 Click Start in the Windows taskbar, and click Control Panel.

2 Click Printers and Faxes to open the Printers and Faxes window.

3 Click Add a printer in the window area on the left.

Note: The Add Printer Wizard can also be started by clicking Add printer in
the File menu of the Printers and Faxes window.

4 The Add Printer Wizard appears. The wizard provides you with step by step
driver installation instructions. Follow the instructions on each page, and then
click Next to proceed to the next page.

Note: If the Found New Hardware Wizard page appears, click Cancel. If the
Hardware Installation warning dialog box appears, click Continue Anyway.

5 When the Completing the Add Printer Wizard page appears, installation of
the printer driver is now complete. To close the Add Printer Wizard, click
Finish. If prompted, restart your computer.

Printer Driver Settings Access
The printer driver software can be accessed from the Print dialog box of an
application, or from Start. If accessed from an application, then changes made
to driver settings remain in effect until the application ends. If accessed from
Start, changes are maintained as the default printer settings.

Changing the Default Driver Settings
The Reset button is only available when you access Preferences or
Properties from the Print dialog box of an application. Default driver settings
apply to printing jobs initiated from any application, but they are overridden by
setting changes made within each application.

1 Click Start, then click Control Panel and double-click Printers (Windows
Vista), or Printers and Faxes (Windows XP).

2 Right-click on your printing system icon.

3 Click Printing Preferences.
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2 Device Settings

In the Device Settings tab, you can select installed printing system options so
the associated features can be used with the printer driver. You can also match
the memory setting in the driver with the memory installed in your printing
system, which lets the driver manage font downloads more efficiently.
Administrator, User, PDL (Page Description Language), and Compatibility
settings can also be selected.
These features are available in the Device Settings tab:
Device Options on page 2-2
Auto Configure on page 2-3
Memory on page 2-4
RAM Disk on page 2-4
Administrator Settings on page 2-5
User Settings on page 2-9
PDL (Page Description Language) on page 2-10
Compatibility Settings on page 2-14

Accessing the Device Settings Tab
The Device Settings tab can be accessed from the Printers (Windows Vista),
or Printers and Faxes (Windows XP) folder.

1 Click Start, then click Control Panel and double-click Printers (Windows
Vista), or Printers and Faxes (Windows XP).

Printing System Driver 2-1



Device Settings

2 Right-click the printer icon, and click Properties.

3 Click the Device Settings tab.

Device Options
Optional devices extend the capabilities of your printing system for source,
finishing, and job storage.
In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

Setting Device Options
You can set the printer driver to match the optional devices installed on your
printing system.

1 In the Printer Properties dialog box, click the Device Settings tab.

2 In Device Settings > Device options, select the check boxes for all installed
devices.

Note: Auto Configure is not available for some models.

Setting Up Virtual Mail Boxes
Virtual mail boxes must be set up in the Device Settings tab in order to use the
Virtual mail box feature in the Job tab.

1 Install a hard disk in the printing system.

2 In the Device Settings tab, under Device options, select Hard disk. If
necessary, clear the RAM disk check box.
-OR-
If Hard disk is already selected, double-click the blue text.

3 In the Hard Disk Settings dialog box, click New.

A new Mailbox name and Virtual output tray number appear.

4 If desired, change the name and number in the Mailbox name and Virtual
output tray boxes. The name length can be up to 31 characters, and number
must be within a range of 1 to 255.

5 Click OK in the Hard Disk Settings and Properties dialog boxes.

The new mailbox name appears in the Virtual Mailbox Selection dialog box
when printing.

You can remove a Virtual mail box by selecting it in the Defined names list
and clicking Delete.
You can import a Virtual mail box list by clicking Import and browsing for a
valid Virtual Mail box list file (.CSV).
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You can save the Virtual mail box list (.CSV) in your computer or network by
clicking Export. A saved list can be imported into another printer driver.

Auto Configure
Auto Configure detects the devices installed on the printing system if it is
connected over a network. When your computer is connected to the printing
system through a TCP/IP port, the Auto Configure button appears in the
Device Settings tab. Auto Configure updates the Device options list and
preview images to keep the printer driver consistent with the printing system
configuration.
Not all installed devices are detected by using Auto Configure. Before
selecting OK in the Device Settings tab, check the settings to make sure that
they are correct.

Note: The default setting for Windows XP Service Pack 2 is for the Windows
Firewall to be set to On. The setting can be changed to allow communication
between the printing system and your computer. In the Windows Security
Alert dialog box, click Unblock.

Silent Auto Configure
Silent Auto Configure checks the printing system every 10 minutes for
changes in optional devices or memory. When a change is detected, the driver
is automatically updated with the new settings. Silent Auto Configure is
available only for Windows Vista OS for printing systems connected to a
network.
In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

Enabling Auto Configuration
The Auto Configure button can be used to detect all available device options
when the printing system is connected to a network through a TCP/IP port.

1 Verify that all optional devices are attached to the printing system, and that it is
turned on and ready to print.

2 In the Device Settings tab, click Auto Configure.

In Windows 2000 and Windows XP, the driver settings are updated
immediately.
In Windows Vista, the Auto Configure dialog box opens. Select from Auto
configure options:

Auto Configure Now
Click the button at any time to retrieve the current settings from the printing
system. It is recommended to do this when the driver is first installed and
when Silent auto configuration is turned off.
Silent auto configuration
Select to let the driver check the printing system every 10 minutes for any
changes in optional devices or memory. When a change is detected, the
driver is automatically updated with the new settings.
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Memory
Memory is the amount of standard and optional memory installed in the printing
system. To maximize the downloading of printing system fonts, the driver must
be set to match the total printing system memory.

Setting the Memory
By default, the Memory setting matches the standard memory in the printing
system. If optional memory is installed, set the memory in the printer driver to
match the total amount of memory.

1 Install optional DIMM memory in the printing system.

2 In Device Settings, at the Memory text box, select the amount of total installed
memory by clicking the up and down arrows until the text box shows the correct
number of megabytes (MB).

You can use the Auto Configure feature to obtain memory information from the
printing system.

RAM Disk
If a hard disk is not installed, the RAM disk functions as a virtual hard disk,
saving print requests into the printing system’s memory. Because the RAM disk
is volatile memory, all data sent to the printing system is lost when the power is
turned off.

Note: When a hard disk is installed, the RAM disk feature is inactive.

Selecting Ignore application collation in the Compatibility Settings dialog
box lets the driver control collation. RAM disk can then increase the print speed
of collated multiple copies by sending the print job just once.
In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

Setting RAM Disk
If a hard disk is not installed, you can set the RAM disk to save print requests
into the printing system’s memory.

1 In Device Settings, in the Device options list, select RAM disk.

2 At the RAM disk text box, type or select the size of the RAM disk by clicking the
up and down arrows until the text box shows the correct number of megabytes
(MB).

3 At the printing system's operation panel, turn on RAM disk and set its size.

The maximum RAM disk size depends on the amount of installed memory.

User Guide2-4



Device Settings

Administrator Settings
Administrator Settings lets you specify Job accounting IDs, an Operation
panel message, display the Quick Print tab, select Lock Security Settings,
SNMP Settings, and set a password to control access.
In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

Job Accounting
Job accounting gives an administrator control of a printing system. With Job
accounting, you can assign account IDs (identification numbers) to users or
departments, a specific account ID, or make account ID input mandatory for
printing. After account IDs are created, you can view from the printing system
operation panel the number of copies associated with a specific ID as well as
limit the number of copies for individual IDs. Account IDs can be up to 8 digits.

Note: Job accounting must be set to On at the printing system. A maximum
of 1000 account IDs can be assigned at the printing system and stored in the
printer driver.

Job Accounting Options

Job accounting supports the following options:
Use specific account ID
Select this option to track the print jobs of a user or group with an account ID.
It will send the account ID with each print job. An administrator can restrict a
user or group from changing their account ID by using the Password
protect administrator settings in the Administrator Settings dialog box.
Prompt for account ID
Select this option to track the print jobs of a user or group with an account ID
as well as prompt for an account ID. At the time a print job is sent, the user
will be prompted to enter a Job Accounting ID.
Prompt for account ID and validate
Select this option to prompt for an account ID that is saved in the driver.
When sending a print job, type an account ID when prompted, then click OK
to print. The account ID is validated against the account ID list. If typed
incorrectly, you will be prompted to type it again.
Display account ID list
Select this option to display the account ID list at the time of printing. The
print job can be assigned to a user or group. The account ID list is stored in
the driver and more than one ID must be established for the list to appear.
Account ID List
Select this option to display the account ID to manage the Account ID list.
Add, edit or delete account IDs from the list stored in the driver. Account IDs
descriptions match the user or group with an account ID. After an account ID
list is created, the list can be exported as a group by saving it as a text file
(.CSV). To import an account ID list, browse for an existing list and open it.

Printing with Job Accounting

After account IDs are assigned and Job accounting is set to On at the printing
system, the number of pages printed is added to the selected account ID total.

1 In the Device Settings tab, click Administrator.
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2 In the Administrator Settings dialog box, select Job accounting.

3 Select a Job accounting option:

Use specific account ID
Prompt for account ID
Prompt for account ID and validate
Display account ID list

4 Select Account ID List to create and manage account ID lists.

5 Click OK in all dialog boxes.

6 Print the document from the application.

7 For some options, when the Print Options dialog box appears, type or select
an account ID, and click OK.

Operation Panel Message
You can specify settings to display the job name, user name, or department for
the current job on the printing system's operation panel during printing. The
printing system default names appear unless you set your own user-defined
names.
You can set job name in the Job tab, and set the user name and department in
the User Settings dialog box.

Displaying the Operation Panel Message

You can select job information to display on the operation panel.

1 In the Device Settings tab, click Administrator.
The Administrator Settings dialog box opens.

2 Select the Operation panel message check box.

3 Select from the following options to display on the operation panel during
printing:

Display job name
Display user name
Display department

Show Quick Print Tab
This option lets you control the display of the Quick Print tab. You can define
basic print options into group profiles that can be accessed quickly and easily.
With a cleared Show Quick Print tab check box, the tab does not appear in the
Printing Preferences dialog box.
With a selected Show Quick Print tab check box, the tab appears in the
Printing Preferences dialog box. When you select the Show Quick Print tab
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check box, you can also access the other two check boxes, Hide other tabs,
and Set Quick Print tab as default.

Selecting Hide other tabs displays only the Quick Print tab to the user.
Selecting Set Quick Print tab as default opens to this tab when you access
Printing Preferences.

Lock Security Settings
If the Security Watermark plug-in is installed, Lock Security Settings appears
in the Administrator Settings dialog box. The administrator can ensure that a
security watermark is printed on all jobs by locking this feature.

Administrator Password
You can set Password protect administrator settings in the Administrator
Settings dialog box to prevent unauthorized changes in this dialog box. When
selected, this setting will prompt you to enter a password and confirm the
password. This password protection blocks access to Job accounting,
Operation panel message, Show Quick Print tab, Lock Security Settings,
and SNMP Settings.

Setting the Administrator Password

1 In Device Settings > Administrator Settings, select Password protect
administrator settings.

2 In the Password dialog box, enter a password, using at least 4 and no more
than 16 characters. Reenter the password in Confirm password and click OK.

Clearing the Administrator Password

1 In the Device Settings tab, click Administrator.

2 In the Enter Password dialog box, type the password and click OK.

3 In the Administrator Settings dialog box, clear the Password protect
administrator settings check box.

4 Click OK.

SNMP
Simple Network Management Protocol (SNMP) is a set of rules that govern the
management of network devices, such as printing systems. SNMP settings
determine the level of security when using the Auto Configure feature, and
prevent unauthorized printing to the SNMPv3 printing system. SNMP settings
must be set in the printer driver and in the printing system’s Embedded Web Server.
The following SNMP options are available:

SNMPv1/v2c
This option ensures successful Auto Configure communication using Read
community name and Write community name.
SNMPv3
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This option ensures secure Auto Configure communication using a user
name and password. Authentication and privacy options are available by
selecting Settings.
Apply to other models
Select from the list of installed printing systems to apply the selected SNMP
settings.

SNMPv3 Options

You can select SNMPv3 options for secure communication with the printing
system.
For some models, SNMPv3 is enabled when an optional network card is
installed. These settings must match the network card settings. The network
card has settings for both an authentication password and an encryption
password, but they must both match the driver password.

Authentication
This option provides an algorithm to check that a transferred file has arrived
intact. Message Digest 5 (MD5) and Secure Hash Algorithm 1 (SHA1) are
hash algorithms used to authenticate packet data.
MD5
This option provides a cryptographic hash function with a 128–bit hash
value. It adds security and protection against Gateway Load Balancing
Protocol (GLBP)-spoofing software.
SHA1
This option produces a message digest that is 160 bits long. SHA1 is the
successor to MD5.
Privacy
This option uses encryption for secure communication. It is available after
you select the Authentication option. You may select one privacy option.
(The network card does not support AES encrypted communication.)
DES
This option uses the Data Encryption Standard for encryption. DES turns
cleartext into ciphertext via an encryption algorithm. It encrypts and decrypts
data using 8-byte blocks and a 56-bit key.
AES
This option uses the Advanced Encryption Standard for encryption. AES is a
symmetric block cipher that can process data blocks of 128 bits, using cipher
keys with lengths of 128, 192, and 256 bits. It is more secure than DES.

Selecting SNMP Settings

SNMP settings in the driver must be set to match the settings in the printing
system’s Embedded Web Server.

1 In Device Settings > Administrator, click SNMP Settings.

2 Select SNMPv1/v2c or SNMPv3.

For SNMPv1/v2c, type the Read community name and Write community
name, up to 32 characters, and click OK.
For SNMPv3, type a User name up to 32 characters, and a Password from
8 to 32 characters.
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3 To set authentication and privacy options for SNMPv3, click Settings.

4 In the SNMPv3 dialog box, select from the available options.

5 Click OK in the SNMPv3 dialog box.

6 Optional: You can click Apply to other models and select from available
models. The SNMP settings are applied to all selected models.

User Settings
User Settings lets you specify user and department names, select the default
unit of measure, and change the driver display language.
In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

Identification
Identification lets you identify your print job with a User name and
Department name, up to 31 characters, that can appear in the Operation
panel message. The User name can be used to identify a print job stored on
the hard disk.

Setting User Identification

You can type User name and Department information to be used with the
Operation panel message and Job Storage (e-MPS) features.

1 In Device Settings > User, type your preferred name in the User name text
box.

2 Type your department or group name in Department text box.

You can type up to 31 characters in the User name and Department text
boxes.

Units
You can set Inches or Millimeters as the unit of measurement. This is used for
the following settings:

Custom page size setting in the Page Sizes dialog box in the Basic tab.
Spacing setting in the Watermark Add and Edit dialog boxes in the
Advanced tab.
Poster settings and Gutter settings in the Layout tab.

Selecting a Unit of Measurement

You can select a unit for displaying measurements in the user interface.

1 In the Device Settings tab, click User.

2 Select Inches or Millimeters.
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Language Preference
The Language preference option specifies the user interface language of the
Device Settings tab of Printer Properties and all tabs of Printing
Preferences.
Available languages vary depending on your locale and your computer settings.

Setting Language Preference

You can select a user interface language.

1 In Device Settings > User, select the desired language from the Select
language list.

2 Click OK in the User Settings and Properties dialog boxes.

PDL (Page Description Language)
A Page Description Language (PDL) specifies the contents and layout of a
printed page. In the Device Settings tab, you can choose from PCL XL,
(Printer Command Language XL), PCL 5e, KPDL (an emulation of PostScript
printing), or PDF (Portable Document Format). The printer default is PCL XL,
which is suitable for most printing purposes. After you select a PDL, the
selection appears in the lower corner of the Preview image.
In GDI compatible mode, vector graphics are rasterized for printing as bitmap
images. Use the GDI compatible mode option to improve the output quality of
the graphic created by the application.

Note: To add PDF to the list of PDL choices, you must install the Output to
PDF plug-in.

In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

PDL Options
The PDL options, available in the PDL Settings dialog box, are accessed in
Device Settings.

PCL XL
The most recent version of HP PCL and PCL 6. This PDL includes PCL 5e
features. PCL XL lacks backward compatibility with earlier PCL versions,
though it is enhanced over PCL 5e in these areas:

Reduced file size
Better print speed
Faster return to application

PCL 5e
Fully compatible with earlier PCL versions
Bidirectional communication support
Wide selection of fonts for use with Microsoft Windows applications
Complex graphics might not print as well
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KPDL
KPDL is used when printing from applications that support PostScript 2 or 3.

An emulation of PostScript printing
Strong graphics reproduction
Print speeds may be slower than PCL 5e
Requires more printing system memory than PCL 5e
Enables native TrueType font downloading
Supports most Graphics settings options

PDF
Output to PDF is a plug-in that lets you print or save documents from multiple
sources to Adobe Portable Document Format (PDF). The PDF format is
independent of the operating system and application software used to create
documents.

Note: With PDF selected as the PDL, only a limited set of driver options is
available.

Use as an alternative to existing commercial applications for creating PDF
documents.
Documents saved as PDF retain their original appearance, and can be
viewed and printed with the free Adobe Reader on Windows, Mac OS, and
UNIX platforms.

Selecting PDL Options

You can select a page description language from PDL options.

1 In Device Settings > PDL, select the desired page description language from
the Select PDL list.

2 Select the GDI compatible mode option to improve the output quality of
graphics created by your application.

3 Settings is available when the PDL is set to PCL XL, KPDL, or PDF.

If you select PCL XL as the PDL, you can click Settings to open the PCL XL
Settings dialog box. Disable auto media type switching controls how
automatic media switching behaves when the selected paper source runs
out paper. When selected, printing stops until you load more paper of the
same size and type. When the check box is clear, the printing system
automatically switches to another paper source loaded with the same page
size and media type.
If you select KPDL as the PDL, you can click Settings to open the KPDL
Settings dialog box. Select the Allow data passthrough check box to
reduce errors when printing complex jobs from applications that use
PostScript formatting.
Note that if you select Allow data passthrough, EMF spooling is not
available in the Advanced tab.
If you select PDF as the PDL, you can click Settings to open the PDF
Settings dialog box.

4 Click OK in the PDL Settings dialog box.
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PDF
Output to PDF is a plug-in feature that lets you print and save documents from
multiple sources to Adobe PDF. This feature can be used as an alternative to
existing commercial applications for creating PDF documents. Documents
saved as PDF retain their original appearance, and can be viewed and printed
with Adobe® Reader® on Windows, Mac OS®, and UNIX® platforms.
For a document using mixed paper sizes, all pages in the PDF use the size of
the first page.

Note: With PDF selected as the Page description language, only a limited
set of driver options are available.

PDF Options

You can select PDF options if you have installed the Output to PDF plug-in.
The PDF Settings dialog box contains the following options:

PDF Settings
Embed fonts
This option ensures that document fonts appear accurately in the PDF file on
screen. This option ensures accurate reproduction but significantly increases
the file size.
Compress data
This option enables flat compression for the generated PDF document. This
option significantly reduces the file size. Additional compression options are
available within Adobe Acrobat.
Security
This option applies encryption to the PDF document. Click Settings for
additional Security settings. See the next section for details.
Print and save
This option lets you print and save a document as a PDF file. Click Settings
for additional Print and save settings.

Security Settings
This option lets you select an encryption level and create passwords for the
generated PDF file.
The following security options are available:

Encryption
Encryption provides password protection so that a document cannot be
opened or altered by unauthorized users.
40-bit
This encryption option provides low level security for a PDF document. It is
supported for earlier versions of Adobe Acrobat and Adobe Reader 3.0 - 4.x.
128-bit
This encryption option provides high level security for a PDF document. It is
supported for Adobe Acrobat and Adobe Reader 5.0 or later.
Passwords
Select passwords for changing security settings and for opening a
document. Passwords are supported up to 16 characters in length.
Require password to change security settings
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Type an Owner password. Within Adobe Acrobat, this password is required
to change the document restrictions in the Files > Properties > Security
section.
Require password to open document
Type a User password. The user password must be entered at the time the
PDF document is opened. This password must be different from the owner
password.

Print and Save Settings
This option lets you print and save a document as a PDF file.

Save to file only
A PDF file is created and saved locally.
Save to file and print
A PDF file is created, saved locally, and sent to print.

After you select between these two options, you can choose the following
option:

Automatically save to default file
A PDF file can be saved automatically as a default file to be used again.

You can then select from the following options:
Replace default file
This option lets you rename the default file name.
Use default file + date and time
This option lets you use the default name and add a date and time stamp
each time the document is saved.
Default file directory
This option lets you browse to a location to save your PDF.

Printing and Saving to PDF

You can print a document and save it to Adobe PDF, if you have installed the
Output to PDF plug-in.

1 Click Start, then click Control Panel and double-click Printers (Windows
Vista), or Printers and Faxes (Windows XP).

2 Right-click on the desired printing system model.

3 Click Properties, then click the Device Settings tab.

4 Click PDL.

5 In the PDL Settings dialog box, in the Select PDL list, select PDF.

6 Click Settings.

7 In the PDF Settings dialog box, select Print and save.
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8 Click Settings, and select from print and save options. See the PDF Options
topic for details.

9 Click OK in all dialog boxes.

10 Open and print the document.

11 Name and save the PDF file.

Compatibility Settings
Compatibility Settings lets you specify media source values, override the
application's Collate setting, and combine the Source and Media type lists in
the Basic tab.
In a client/server environment, this feature is unavailable to a client logged in as
a restricted user.

Media Source Enumeration
Media source enumeration supports compatibility for media source values
unique to the printer driver, such as those for cassettes or feeders. Your newly
installed printer driver maintains identical media source support with the driver it
replaces, whether for this driver or one from another manufacturer. If media
source macros exist for the older driver, then the alignment of media source
values maintains support without the need to change the macros.

Setting Media Sources

You can reassign an enumerated value to create a match between the drivers if
the values for a given media source differ between printer drivers.

1 In the Device Settings tab, select Compatibility.

2 From the Media source enumeration list, select the paper supply method. The
current value is listed in the Enumerated value box.

3 Type an Enumerated value for the media source, and click Apply. To align
settings with a different driver, this value should align with those in the other
driver.

You can restore all the options in Compatibility Settings to the default by
clicking Reset.

Ignore Application Collation
This option bypasses the Collate setting in software applications, and gives
priority to the printer driver setting.

With the check box selected, the printer driver Collate setting is used.
With the check box cleared, the application Collate setting is used.

Selecting Printer Driver Collation

You can ignore the collation setting in the application and use the printer driver
collation setting.
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1 In the Device Settings tab, select Compatibility.

2 Select Ignore application collation.

You can restore all the options in Compatibility Settings to the default by
clicking Reset.

Combine Source and Media Type Lists
You can change the driver's Basic tab so that Media type and Source are
combined into one list, labeled Source. In the combined list, Media types are
listed first, followed by cassettes and MP tray.

Creating a Combined Source List

You can combine the Source and Media type lists in the Basic tab, to make
one Source list.

1 In the Device Settings tab, select Compatibility.

2 Select Combine source and media type lists.

You can restore all the options in Compatibility Settings to the default by
clicking Reset.
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In the Quick Print tab, you can apply basic print settings to print jobs. Any
Quick Print settings can be saved as a group, called a profile, and applied to
any print job. Profiles support common printing tasks.
The Administrator can set the view of the Quick Print tab through the
Installation process, or Administrator Settings in Properties.
These features are available in the Quick Print tab:
Quick Print Options on page 3-1
Profile Options on page 3-3

Quick Print Options
You can set one or more print options on the Quick Print tab. You can also
select from profiles that have been set with predefined options for frequently run
print jobs.

Specifying Print Options
The upper section of the Quick Print tab has several icons that represent the
most common options for print jobs. Click on the Quick Print icons and check
boxes to change settings for the print job. Some of these options also appear on
the Basic, Layout, and Imaging tabs. The last tab where you made selections
affects the selections you will see on the other related tabs.

Orientation
This icon changes between portrait and landscape printing formats. If
needed, check Rotated to change the orientation of the printed page by 180
degrees.
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EcoPrint
This icon changes the text and graphics to appear lighter in the printed job.
EcoPrint does not increase print speed.
Collate
This icon changes the ordering of the printed pages. The page ordering
sequence can either be 123, 123, 123, or 111, 222, 333, and so on.
Print on both sides
This icon changes between duplex printing for flipping on the long edge,
duplex printing for flipping on the short edge, or for not using duplex printing.
Multiple pages per sheet
This icon changes between Off, 2, and 4 for the number of pages printed on
one sheet. For more than 4 pages per sheet, define these settings in Layout
> Multiple pages per sheet.

Any basic print options can be Reset to the default values in the Quick Print
tab. This button only appears when it is accessed from an application’s Print
dialog box.
The following sections describe some of the Quick Print tab options in more
detail. Collate, Duplex printing, and EcoPrint can also be found in the Basic
and Imaging tabs, and Multiple pages per sheet in the Layout tab. The
Profiles options are accessed from Printing Preferences.

Collation
Collate specifies the order in which the pages of a multiple copy job are printed.
With Collate selected, the first time the print job is sent to the printing system
the data is rendered as page images in the printing system's memory. The
remaining job copies are printed from the stored data. This avoids the extra
processing involved in sending every copy from the computer to the printing
system.
With Collate selected, the driver prints the complete job set by set. With Collate
cleared, it prints each page by set. For example, with Collate selected, three
copies of a five-page document outputs as pages one through five in
succession, three times.

Duplex Printing
Duplex printing is printing on both sides of each page. Select Print on both
sides to start duplex printing. If it is not selected, then the printer prints on only
one side of each page. The printer system contains a duplex unit that turns the
paper over to allow printing on the reverse side. Print on both sides must be
selected to print on both sides of the cover and insert pages.

Flip on long edge
Turn the long edge of the page to view the content, like the pages of a book
bound at the side.
Flip on short edge
Turn the short edge of the page to view the content, like a tablet bound at the
top.

Multiple Pages per Sheet
Multiple pages per sheet prints several pages on a single sheet of paper for
the purpose of reviewing the document and conserving paper. The readability of
the multiple pages decreases as the number of pages per sheet is increased.
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You can set the arrangement of the pages from the Layout tab as well as print
borders around each of the pages.

Profile Options
In the Profiles section, you can select from available profiles to print a job. You
can select from predefined profiles, or you can create your own profile, and
import profiles. You can also rearrange the icons and edit and delete profiles.

Selecting Profiles
The Profiles button at the bottom of the Quick Print tab always includes a
Factory Default profile that returns the driver options to their default settings.
The profiles can include Common Profiles, which are installed as optional
components through the Printer Installation Wizard, and any custom profiles
created. Factory Default and administrator profiles cannot be modified.

1 Click Profiles.

2 In the Profiles dialog box, select a profile.

3 Click Apply.

The side panel displays the options for that profile. If any of the Quick Print
options are not represented in the predefined profile, the Quick Print icon will
be unavailable.

4 Click OK.

Saving a Profile
The Save button lets you create your own profiles. You can select the printing
options you want in the driver, then save the driver settings including your
customizations as a profile. You can then use that profile to print the same type
of print job again without having to reselect all the settings. In Printing
Preferences, the Profiles button appears at the bottom of all the tabs.

1 Set the printing options you want for your print job by opening Printing
Preferences and selecting all your driver settings.

2 Click Profiles > Save.

3 To identify the profile, type a Name, select an Icon, and type a Description.

4 Click OK to save the profile.

The newly added profile appears in the Profiles dialog box.

5 Click Apply to activate the selected profile to the current print job, or click OK to
save the profile.

Note: To reset the printer driver to default settings, select the Factory Default
profile, and click Apply. This clears the settings of a selected profile.
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Editing a Profile
The Edit button lets you make changes to an existing profile. The Factory
Default profile cannot be edited.

1 Click Profiles.

2 In the Select profile section, highlight the profile to be edited, and click Edit.

3 Any of the three options can be edited: name, icon and description. Click OK to
save the edited changes.
The newly edited profile appears in the Profiles dialog box.

4 Click Apply to activate the selected profile to the current print job, or click OK to
save the profile.

Deleting a Profile
The Delete button lets you remove an existing profile. The Factory Default
profile cannot be deleted.

1 Click Profiles.

2 In the Select profile section, highlight the profile to be deleted, and click
Delete.

3 A message appears confirming the removal of the profile. Click Yes to remove.

4 Click OK to close the Profile dialog box.

Importing a Profile
The Import button lets you import a copy of a profile from other printer drivers
into your printer driver.

1 Click Profiles > Import.

2 Browse for the existing profile (.KXP), select it, and click Open.

A message appears if any of the profile settings in the imported file are not
available in the existing driver. Select Yes, to import the profile, or No, to cancel
the import.

3 If you selected Yes in the previous step, the newly imported file appears in the
Profile dialog box.

4 Click Apply to activate the selected profile to the current print job, or click OK to
save the profile.

Exporting a Profile
The Export button lets you export a copy of a profile from your printer driver for
use in other printer drivers. The Factory Default profile cannot be exported.
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1 Click Profiles.

2 In the Select profile section, highlight the profile to be exported, and click
Export.

3 The Export Profile dialog box appears. Name and save the profile.

4 Click OK to close the Profiles dialog box.
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In the Basic tab, you can specify the most commonly used printer driver
settings.
These features are available in the Basic tab:
Creating a Custom Page Size on page 4-3
Printing with Custom Size Pages on page 4-3
Printing in Duplex Mode on page 4-4
Printing Collated Documents on page 4-5

Basic Paper Settings
The Basic tab contains several settings for the most commonly used printing
tasks.

Print size
This setting sets the size of the area that the printer prints to, regardless of
the actual paper size that is used by the printing system.
Source
This setting specifies the cassette or tray that the printing system draws
paper from. Unless you are using a custom paper type, you can leave it set
to Auto source selection.
Media type
This setting selects the Source based on the types of media that are
specified in the printing system. In general, you can leave it set to Auto
media selection.
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Destination
This setting specifies which output tray is used for the print job output.
Orientation
This setting specifies the paper orientation of the print job. If Rotated is
selected, the print job orientation is rotated 180 degrees.
Copies
This setting specifies the number of copies to print. For collating multiple
copies, select Collate.
Print on both sides
This setting enables duplex printing.
EcoPrint
This setting makes the entire image, text and graphics, appear lighter in the
printed job. EcoPrint does not increase print speed.

Note: Some applications may override print settings made in the driver.
Usually the application can be set to follow the settings. In Microsoft Word
2007, ensure that Default tray in Options is set to Use printer settings.

Source and Media Types
In the Basic tab, Source specifies which tray or cassette the printer uses for a
printing job. The default is Auto source selection, which instructs the printer to
search for the media requested by the application or the printer driver. If the
selected tray or cassette empties during a print job, then the printer searches for
another source, and continues the job.
Media type instructs the printer to search for the type of paper or media that is
requested by the application or the printer driver. The choices shown may
change depending on the selection in Source. If Auto media selection is
selected, then the printer searches for another tray or cassette using the same
media.
Transparencies must be printed using the MP tray, and labels and envelopes
require the MP tray. Ensure the paper is properly loaded by following the
instructions outlined in the printing system's Operation Guide.

Note: Source and Media type are separate items in the dialog box, but can
be combined using the Combine source and media type lists setting in
Compatibility Settings. If they are combined, Media type is not available on
the Basic tab. To change this setting, open Device Settings > Compatibility
Settings and clear the Combine source and media type lists selection.

Print Size and Page Size
Print Size controls the output page size of the document. To use this setting,
ensure that the Page Sizes setting matches the page size setting in your
application. If the Print Size is different from the page size in your application,
then each page will be enlarged or reduced to match the Print Size. The
percentage value shown in brackets indicates the size of the Print Size setting
relative to the Page Size setting. If the Page Sizes does not match the page
size setting in the application (the size of the original), then, in most cases, the
Print Size is ignored and the document prints out based on its original size.
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You can create a page size with your chosen dimensions for printing on
non-standard size paper. You can then save the custom setting to the Page
Sizes and Print Size lists for later selection.

Creating a Custom Page Size
To use custom page sizes, they must be created and added to the Print size
list. The driver supports a maximum of twenty custom sizes.

1 In the Basic tab, click Page Sizes.

2 Click New.

3 A default custom name appears in the Name box. Type a name for your custom
page size.

4 Type or select values for the height and width. If the height or width value
exceeds the allowable limit, it automatically adjusts to the limit after Apply or
OK is clicked.

5 When done, click Apply.

The custom page size appears in the Print size list, which is used for enlarging
and reducing the sizes of prints.
To delete a custom page size from the Page Sizes dialog box, select the name
of the custom page size and click Delete.

Printing with Custom Size Pages
You can print on custom-sized pages (or other media such as transparencies)
by performing these steps:

1 In your application, select Print from the File menu.

2 In the Print dialog box, click Properties.

3 In the Basic tab, select the name of your custom page size in the Print Size list.

4 From the Source list, select the MP tray for the custom page size. Click OK to
return to the Print dialog box. Click OK to start printing.

Duplex Printing
Duplex printing is printing on both sides of each page. Select Print on both
sides to start duplex printing. If it is not selected, then the printer prints on only
one side of each page. The printer system contains a duplex unit that turns the
paper over to allow printing on the reverse side. Print on both sides must be
selected to print on both sides of the cover and insert pages.

Flip on long edge
Turn the long edge of the page to view the content, like the pages of a book
bound at the side.
Flip on short edge
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Turn the short edge of the page to view the content, like a tablet bound at the
top.

Flip on long edge

Flip on short edge

Printing in Duplex Mode

1 In the Basic tab, select Print on both sides.

2 Select either Flip on long edge or Flip on short edge.

Collation
Collate specifies the order in which the pages of a multiple copy job are printed.
With Collate selected, the first time the print job is sent to the printing system
the data is rendered as page images in the printing system's memory. The
remaining job copies are printed from the stored data. This avoids the extra
processing involved in sending every copy from the computer to the printing
system.
With Collate selected, the driver prints the complete job set by set. With Collate
cleared, it prints each page by set. For example, with Collate selected, three
copies of a five-page document outputs as pages one through five in
succession, three times.
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Printing Collated Documents
When printing multiple copies of a multiple page document, the printer can
assemble the pages of each copy in numerical order.

1 In your application, open the Print dialog box and click Properties.

2 In the Basic tab, select the Collate check box.

3 Type or select the number of complete sets of the print job in the Copies box.
The document page count must not exceed the printer tray capacity.

4 Click OK to return to the Print dialog box, and click OK to begin printing.

EcoPrint
EcoPrint makes the entire image, text and graphics, appear lighter in the
printed job. EcoPrint does not increase print speed.

About
The About button on the bottom portion of any Printing Preferences screen or
the Device Settings screen opens a dialog box that displays the driver version
number and driver plug-in information.

Displaying Version Information
Click Version to view the following driver information:

File Name
Version
Description
Date
Manufacturer
Comments

To view copyright information, click Legal Notices.
Click OK to close the driver information dialog boxes.

Displaying Plug-in Information
Click Plug-in to view the following plug-in information:

Module
Description
Version

Removing a Plug-in

You can remove an installed plug-in from the driver. When removed, the plug-in
features will not appear in the driver interface.

1 Click Start, then click Control Panel and double-click Printers (Windows
Vista), or Printers and Faxes (Windows XP).
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2 Right-click the desired printer icon.

3 Select Properties.

4 Select the Device Settings tab.

5 Click the About button to open the About dialog box.

6 Click Plug-in to open the Plug-in Information dialog box.

7 Select a plug-in module from the list and click Delete, then Yes.

8 Click OK in all dialog boxes.

Note: To remove the Output to PDF module, PDF must not be selected in
the PDL Settings dialog box.
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In the Layout tab, you can arrange document data on printed pages without
affecting the original document.
These features are available in the Layout tab:
Printing a Booklet on page 5-1
Printing Multiple Pages per Sheet on page 5-2
Printing a Poster on page 5-3
Setting Scaling on the Page on page 5-4
Creating a Gutter on page 5-4

Booklet
Booklet prints a two-page layout on both sides of each sheet of paper. You can
fold and bind the booklet in the center. Folded booklets are half the size of the
selected paper. For example, if you select Letter in Basic > Paper > Print size,
the printed output can be folded into a 5.5 x 8.5 inch-size booklet.
When Booklet is selected, other options such as Multiple pages per sheet,
Poster, and Scaling are unavailable.
A different paper source can be selected for the booklet cover. To include a
cover on the booklet, select the Publishing tab, then select Cover mode.

Printing a Booklet
Booklet printing requires that you choose left edge binding or right edge binding
as in the following:
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1 In the Layout tab, select Booklet, and one of the two binding options.

Left Edge Binding
This selection prints text that reads from left to right.
Right Edge Binding
This selection prints text that reads from right to left.

2 Click OK to return to the Print dialog box.

3 Click OK to begin printing.

Multiple Pages per Sheet
Multiple pages per sheet prints several pages on a single sheet of paper for
the purpose of reviewing the document and conserving paper. The readability of
the multiple pages decreases as the number of pages per sheet is increased.
You can set the arrangement of the pages from the Layout tab as well as print
borders around each of the pages.

Printing Multiple Pages per Sheet
This section describes selecting and printing an arrangement of pages on a
single sheet of paper.

1 In the Layout tab, select Multiple Pages per sheet.

2 In Pages per sheet, select the number of pages to print on each sheet of paper.

3 If you want to print a border around each page, select Print borders.

4 In the Layout list, select the horizontal direction the pages should flow.

5 Click OK to return to the Print dialog box.

6 Click OK to begin printing.

Poster
Use Poster to print a document to a size that is larger than the paper your
printer can support. You can print a poster, or banner, up to 25 times larger than
the original document. Segments of the poster document are printed on several
sheets of paper and with the assistance of poster settings, you can reassemble
the sheets easily to create a poster.
Use Sheets per page to select the poster size in relation to the original
document size. Each option shows the number of sheets to be printed and the
maximum poster size.

Note: The Sheets per page displays the unit of measurement in inches or
millimeters. To change the Units setting, open the Printers and Faxes folder,
right-click your printer. Click Properties > Device Settings > User.
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Use Poster Settings to select options, in any combination to make it easier to
create a poster. These options print visual cues on the poster sheets that
provide help in cropping and assembling the pages.

Overlap edges
This selection duplicates the edges of document data on adjoining sheets.
Poster appearance is improved when the edges overlap slightly. Select the
check box, then type or select a value between 0.00 and 1.20 inches (0.0
and 30.4 mm). This option reduces the final poster size slightly.
Print crop marks
This selection prints a border at the edges of each poster sheet. You can
crop each sheet on the border before assembling the sheets. This option
ensures that data on adjoining sheets matches precisely.
Print assembly marks
This selection prints numbers at the edges of each sheet, matching numbers
on adjoining sheets. Assemble each sheet edge to the same numbered edge
on another sheet.

Use Print format to print a proof sheet, along with the poster, to guide you in
assembling the printed poster sheets.

Poster pages
This selection prints all of the sheets to be assembled as a poster.
Proof sheet
This selection prints all the poster pages on one sheet with markings that
display the sheet assembly.
Poster pages and proof sheet
This selection prints all poster sheets and a one-page proof sheet.

Printing a Poster
To print a poster or banner, follow these steps:

1 In the Layout tab, select Poster.

2 In Sheets per page, select the poster size. Each option describes the number
of sheets it takes to represent one finished poster page.

3 Click Poster Settings to select options in any combination. These options
ensure a precise assembly of the pages to create the poster.

4 In Print format, select one of the options for a finished print format.

5 Click OK to return to the Print dialog box.

6 Click OK to begin printing.

Scaling
Scaling increases or decreases text and graphics on a page. You can also
select a gutter setting that enlarges the margins to accommodate an easier
assembly of the pages into a booklet. Scaling is not available when Booklet,
Poster or Multiple pages per sheet is selected.
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Setting Scaling on the Page
To set scaling values, follow these steps.

1 In the Layout tab, select Scaling.

2 Type or select a percentage between 20 to 500.

Scaling adjusts proportionately the height and width of the page. A lower
percentage reduces the page and a higher percentage enlarges the page.

3 Click OK.

Gutter
A gutter creates additional blank space on the left side and at the top of the
sheet. It is often used for binding, hole punch or stapling to make a print job
easier to read. Increasing the measurements in Gutter increases the margins
around your text and graphics on the left side, or top of the printed sheet. This
creates a larger margin space by shifting the printable area to the right, or down
as much as one inch (25.4 mm).

Creating a Gutter
To create a gutter, follow these steps.

1 In the Layout tab, click Gutter.

2 In the Gutter width options, type a value between .20 to 1.00 inches (5.0 to
25.4 mm).

Long edge (left)
This selection modifies the outside margin on the left-side of the page.
Short edge (top)
This selection modifies the outside margin on the top-edge of the page.

Note: Availability of Gutter settings varies depending on Orientation and
Duplex mode settings in the Basic tab.

3 If text extends too close to the edge of the page, select Reduce image to fit.
The text appears slightly reduced and away from the edge of the page. If text
does not extend beyond the page when the gutter increases, clear Reduce
image to fit.

4 Click OK to save gutter settings, then click OK again to return to the Print dialog
box.

5 Click OK to begin printing.
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6 Finishing

In the Finishing tab, you can specify document finishing features like stapling
and separation.
These features are available in the Finishing tab:
Staple on page 6-1
Separation on page 6-2

Staple
The Staple feature is available on printing systems with an optional finishing
device installed.
After installation, optional equipment must be selected in the printer driver in the
Device Settings tab.

Note: Staple and Separation features cannot be used together.

If Printer default is selected as the Destination in the Basic tab, the selection
of an option in the Finishing tab results in the automatic selection of a
destination compatible with that finishing option. The destination is
automatically updated to the first available output tray that supports the selected
finishing option.
Staple selects the Destination automatically. If the Finishing options are
changed, the Destination selection is not affected.

Printing System Driver 6-1



Finishing

Stapling a Print Job
The Staple feature in the Finishing tab enables you to create stapled
document sets. You must first select a finisher under Device options in the
Device Settings tab. Staple will make Separation and Transparency
interleaving unavailable. The maximum number of sheets depends upon the
finisher model and the selected Page size or Media type. The Gutter feature
lets you increase the top and left margins to accommodate the location of the
staples.

1 In the Finishing tab, select Staple.

2 In the Staple feature, select Position and Count. Two options are available for
count: All sheets up to the limit displayed in the tab, and every number of pages
so that each number set is stapled separately.

3 Click OK to return to the Print dialog box.

4 Click OK to start printing.

Separation
The Separation feature stacks print jobs so that one print job can be
distinguished from another.
Select Rotate copies to print each copy of a print job at right angles.
Select Offset jobs to physically shift each print job in the output tray. To ensure
consistent offset stacking, all users printing to the same printing system should
select Offset jobs as the default setting.

Rotate Copies
Rotate copies stacks each copy of a print job at a right angle in the output tray.

Note: A hard disk must be installed, or a RAM disk enabled to use this
feature.

This feature requires the following:
Paper size selections are limited to Letter, A4, or B5 (JIS).
The selected paper size must be loaded into two paper sources, one
horizontally and one vertically.
The print job must contain multiple pages and be specified to print multiple
copies.

Rotating Copies

Rotate copies stacks each copy of a print job at right angles.

1 In the Basic tab, under Destination, select an option that is not a finishing tray,
for example: Top tray (face-down).

2 Select a number of copies greater than 1.

3 Click the Finishing tab, then select Separation > Rotate copies.
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4 Click OK to return to the Print dialog box.

5 Click OK to start printing.

Offset Jobs
The Offset jobs feature physically shifts each print job in the output tray.
To ensure consistent offset stacking, all users printing to the same printing
system should select Offset jobs as the default setting.

Offsetting Jobs

The Offset jobs feature requires a finishing device to be selected under Device
options in the Device Settings tab. It does not work with Staple feature.

1 In the Basic tab, under Destination, select a face-down finishing tray.

2 Open the Finishing tab, then select Separation > Offset jobs.

3 Click OK to return to the Print dialog box.

4 Click OK to start printing.
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In the Imaging tab, you can manage print quality and grayscale settings.
These features are available in the Imaging tab:
Print Quality and Custom Quality on page 7-1
Fonts on page 7-2
Graphics on page 7-4
Adjusting Grayscale on page 7-6
Text and Graphics Effects on page 7-7

Print Quality and Custom Quality
Print quality lets you set the resolution for the print job. Resolution is a
measurement, in dots per linear inch (dpi), that describes the sharpness and
clarity of printed text and images. Custom Quality lets you set a more refined
resolution for the print job.

Selecting Print Quality
In the Imaging tab, select a Print quality from the list. The number of
selections in Print quality depends on the number of resolutions supported by
the printing system.

High quality, Proof, Draft
Select one of these settings to print from the highest to the lowest print
resolution. Proof is unavailable when PCL5e is selected as the PDL.
Custom
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Custom lets you choose a setting for Custom Quality and EcoPrint.
Selecting Custom without EcoPrint results in a default setting to the highest
printing system resolution.
Click Custom Quality to open a settings dialog box with selections for a
more refined resolution. Resolution can be set to Fast 1200, 600 dpi, or
300 dpi. KIR smooths the edges of text and vector graphics and can be set
to On, or Off.

Selecting EcoPrint
EcoPrint changes toner saturation in the printed job, making the entire print
image, including text and graphics, appear lighter. The amount of toner varies
based upon your printing system model and the type of data printed (text,
graphics, or both). EcoPrint is also available in the Quick Print and Basic tabs.

1 In the Imaging tab, in the Print Quality list, select Custom.

2 Click EcoPrint to open the EcoPrint dialog box.

3 To start EcoPrint, select On; to stop it, select Off.

4 Click OK to close the EcoPrint dialog box.

Fonts
A computer font is a data file containing a set of glyphs (visual representations
of textual elements), characters, or symbols. Common terms for fonts are:

Bitmap fonts define each character as a pattern of pixels (the smallest
resolvable rectangular areas of an image). Such fonts are not easily scalable
and distort when reduced or enlarged.
Outline fonts, in contrast to bitmap fonts, are defined as a set of
mathematical lines and curves. An outline font is more easily scalable
(designed to display and print clearly at any point size) than a bitmap font.
Native fonts are the basic or original fonts installed with the computer
operating system. TrueType fonts are the native fonts used by Microsoft
Windows.
TrueType fonts are a type of scalable outline fonts. TrueType has long been
the most common format for fonts on Microsoft Windows.
System fonts are the primary fonts used by the operating system. They are
typically accessed through an application interface or through a common font
dialog box.
Device fonts are stored either permanently or temporarily in the printing
system memory.

Font Settings
The Font Settings dialog box lets you specify how TrueType fonts are sent to
the printing system. The chosen method affects the speed and quality of the
print job:

Download as outlines
This method is best suited for large documents or print jobs using multiple
fonts and font sizes. Print speeds are faster because of the optimization
features in this setting. The repetition of similar font data sent to the printing
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system is reduced, thereby increasing the print speed. Print speed is not
increased when using Asian fonts such as Japanese, Chinese, and Korean,
because of the large amount of font information used for these particular
fonts.
Allow native download
This method improves text quality and increases print speed by converting
TrueType fonts to Adobe Type 42 font format. This feature is available when
KPDL is selected.
Download as bitmaps
Downloading fonts as bitmaps provides more detail, however it creates large
file sizes. This is best suited for print jobs with user-defined fonts, very small
fonts (point size 1-4), or Asian fonts.
Substitute with device fonts
System fonts and device fonts are automatically matched based on typeface
name. This function increases print speed and efficiency. It is useful for
changing a font used throughout a large document, by replacing the old font
with the desired font.

Note: GDI compatible mode does not support Substitute with device
fonts.

Selecting Font Settings

1 Click Fonts to open the Font Settings dialog box.

2 Select one of the methods for sending TrueType fonts, and then click OK.

Font Substitution
Font substitution is the process of using one font in place of another when the
intended font is not available to a printing system. Font substitution may be
critical for output of documents to printing systems that are not well supported
by a large font inventory.

Setting Font Substitution

To set values for font substitution, follow these steps.

1 In the Imaging tab, click Fonts > Substitute with device fonts check box >
Fonts button that opens the Fonts Substitution dialog box.
The System fonts list shows the fonts installed on your computer. The
Available device fonts list shows the printing system fonts.

2 Highlight the system font, and then the available device font to be substituted.

3 Click OK to save your settings. If the device font does not have similar font
characteristics to the system font, character spacing in the document may
appear incorrect.

Disable Device Fonts
In some cases, the printing system substitutes fonts even if you send the
TrueType fonts as outline fonts or bitmap images. Select Disable device fonts
to prevent substitution of device fonts for TrueType fonts.
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This option also improves portability of printable data. (If cleared, device fonts
may not match when sent to a different printing system.)
Some Adobe applications have device font limitations. To overcome these
limitations, select Disable device fonts. Device fonts are normally visible in the
application font lists as printer icons next to the font name, unless there are
equivalent system fonts, in which case the “TT” TrueType icon remains.

Disabling Device Fonts

To disable device fonts, follow these steps.

1 In the Imaging tab, click Fonts.

2 In the Fonts Settings dialog box, select the Disable device fonts check box.

3 Click OK to save your settings.

Graphics
Graphics are pictorial representations of information. Graphics can be functional
(charts, diagrams) or artistic (drawings, photographs). Graphics Settings let
you select pattern scaling, inversion, optimization, and halftone options for your
printed graphics.

Note: Some options are available only when a specific PDL is selected.

1 In the Imaging tab, click Graphics to open the Graphics Settings dialog box.

2 In the dialog box, select from Pattern scaling, Inversion options,
Optimization, and Halftone Screen, and then click OK to save your selections.

Pattern Scaling
Pattern scaling is a feature that can help improve visual compatibility between
screen and print output. Graphics objects, such as a shape or a path, often
include patterns and fills that are composed of collections of printed dots. A
pattern is a planned or random repetition of colors, shapes, lines, values, and
textures to create a visual arrangement. A fill is the application of a color or
grayscale to a graphics object. If printed patterns and fills do not match the
appearance of that on the screen, use Pattern scaling to select a different
density of printed dots.
In the Imaging tab, click Graphics to open the Graphics settings dialog box
and access the Pattern scaling settings.

Auto (default setting)
This setting prints patterns and fills to match the on-screen appearance.
Coarse
This setting prints patterns and fills with the fewest number of lines, patterns,
or dots. Coarse is the same as Auto when PCL XL or PCL 5e is selected in
Device Settings > PDL > Select PDL.
Medium
This setting prints patterns and fills with a greater number of lines, patterns
or dots than the Coarse setting. Medium is the same as Auto when KPDL is
selected in Device Settings > PDL > Select PDL.
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Fine
This setting prints patterns and fills with the greatest number of lines,
patterns, or dots. Printed patterns and fills may appear more dense than the
on-screen appearance.

Inversion Settings
Inversion is the opposite of the normal order, arrangement, or position of an
image or printed content.
In the Imaging tab, click Graphics to open the Graphics settings dialog box
and access the Inversion options. The settings are available when KPDL is
selected as the PDL.

Reverse image
This setting prints images like a photo negative, reversing black and white
areas of the image.
Mirror print
This setting prints the page content backwards, as it would appear in a mirror
image.

Optimization Settings
Optimization is a process or methodology of improving a printing system's
function or effectiveness.
In the Imaging tab, click Graphics to open the Graphics settings dialog box
and access the Optimization settings. The settings are available when KPDL is
selected in Device Settings > PDL > Select PDL.

Fast printing
This setting increases print speed and decreases spool size. It delivers
images in binary format. It can be used for most everyday printing needs.
Document portability
This setting creates a PostScript file in ASCII text encoding. Unlike the binary
format created in Fast printing, the ASCII text created with this selection
can be edited.

Halftone Screen
Halftone Screen lets an experienced user print different shades of gray as are
found in photographs. Shades are produced by printing dots of various sizes
and shapes, and by spacing them closer or farther apart. Shading can also be
adjusted by the number of rows of data, the angle of the rows, and the shape of
the data.
Halftone Screen is available when KPDL is selected as the PDL. It is
unavailable if GDI compatible mode is selected in the PDL Settings dialog
box.

Setting the Halftone Screen

Halftone Screen provides a means to apply shades of gray to black and white
printed output.

1 In the Imaging tab, click Graphics > Halftone Screen.

2 Clear the Use printer's default screens check box.
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3 Set the available options to the desired values:

Ink Lists the halftone screens available. This option is grayed out and
permanently set to black for black and white printers.
Frequency Displays the number of rows of dots per inch or centimeter. Set
the range from 2.0 to 999.9, and select lines/inch or lines/cm.
Angle Sets the angle at which rows are aligned. Set the range from -180 to
180 degrees.
Shape Select the shape of the halftone dot:
Ellipse
Resists optical jump, which is when areas of an image that should be smooth
suddenly become darker. An ellipse shape provides a smoother gradation of
tones. Select Ellipse for images with dark areas.
Round
Resists moiré formation and dot gain. Moiré formation is an unintended
pattern that occurs when two or more colors are printed at the wrong angles.
The correct angles depend on the number of colors being printed. Dot gain is
when the halftone dots increase when printed, causing a moiré pattern.
Select Round for images with light tints and highlighted areas.
Line
Used for special effect. Select Line to change the effect by selecting a
different angle.

4 Select Increase accuracy of screens for better print quality, possibly
increasing print time.

5 Click OK.

Adjusting Grayscale
The grayscale adjustment settings change the Brightness and Contrast of
graphics. These settings are useful if graphic images are printing too light, too
gray, or too dark. Text remains unaffected.

1 In the Imaging tab, under Adjustment, select Custom.

A preview image in the Adjustment Settings dialog box illustrates any
brightness and contrast changes.

2 Drag the Brightness slider right to lighten, or left to darken the graphic images
of the print job.
You can also change brightness by entering a numeric value in the text box at
the right. The brightest setting is +100; the darkest is -100. Zero is the default
mid-level setting. Adjusting brightness is useful when graphic images are
printing too dark or too light.

3 Drag the Contrast slider right or left to increase or decrease the proportion of
light to dark in the graphic images of the print job.
A high contrast setting decreases the grayscale spectrum, making light grays
lighter and dark grays darker. A low contrast setting increases the grayscale
spectrum, making light grays darker and dark grays lighter.
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You can also change contrast by entering a numeric value in the text box at the
right. The highest contrast setting is +100; the lowest is -100. Zero is the default
mid-level setting. Adjusting contrast is useful if graphic images are printing too
gray, or too black and white.

4 Click OK to save your grayscale adjustment settings.

Text and Graphics Effects
Print text as black
This option prints all color text as black. It produces faster printing of color
text by reducing the amount of data sent to the printer. In black and white
printers, it increases the detail for light-colored text printed. White text and
image colors are unaffected.
Print graphics as black
This option prints all color graphics and text with black, rather than
grayscale. This feature is intended for CAD applications.
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In the Publishing tab, you can create covers, inserts, and add transparencies
for a print job.
These features are available in the Publishing tab:
Printing Covers on page 8-1
Choosing Cover Media on page 8-5
Printing Page Inserts on page 8-5
Interleaving Transparencies on page 8-7

Cover Mode
Cover mode is a feature for adding cover pages for the front and back of your
document. You can print on cover pages of a different weight or color than the
main document. The source of the cover paper is specified by adjusting the
Media for cover settings in the Publishing tab.
Print on both sides must be selected in the Basic tab in order to print using the
Front inside or Back outside options.
Although Cover mode and Page insert may be used simultaneously, they
cannot be used with Transparency interleaving.

Printing Covers

1 In the Publishing tab, select Cover mode.
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2 Select Front, Front and back, or the Print onto options to specify what type of
covers to print.

3 Select the Media for cover to specify what type of paper or other media to use
for the covers.

Cover Mode Options

Check Box Selection Cover Insertion Type
Front Inserts a blank front cover.

Front Prints on the outside surface of the
front cover.Front outside

Front Prints on the inside surface of the front
cover.Front inside

— continued
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Check Box Selection Cover Insertion Type
Prints on the outside and insideFront surfaces of the front cover.

Front outside
Front inside

Inserts blank front and back covers.Front and back

Prints on the outside surface of theFront and back front cover and inserts a blank back
cover.Front outside

Prints on the inside surface of the frontFront and back cover and inserts a blank back cover.
Front inside

— continued
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Check Box Selection Cover Insertion Type
Prints on both sides of the front coverFront and back and inserts a blank back cover.

Front outside
Front inside

Prints on the inside surface of theFront and back back cover and inserts a blank front
cover.Back inside

Prints on the outside surface of theFront and back back cover and inserts a blank front
cover.Back outside

Prints on both sides of the back coverFront and back and inserts a blank front cover.
Back inside
Back outside

— continued
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Check Box Selection Cover Insertion Type
Prints on both sides of the front andFront and back back covers.

Front outside
Front inside
Back inside
Back outside

Choosing Cover Media

1 In the Media for cover list, select the media type or source cassette for the front
and back covers.
When you choose the media type, a source cassette matching that media type
is automatically selected.

2 Click OK to return to the Print dialog box.

3 Click OK to start printing.

Page Insert
A Page insert is a preprinted page or a page of a different paper type that is
inserted at specified points in a print job. The inserted page can also be printed
on during the print job. Both sides of the page insert can be printed on by using
the duplex unit.
Although the Page insert and Cover mode options can be used together,
neither of them can be used with Transparency interleaving.

Printing Page Inserts
There are several ways to arrange page inserts: you can print on one, both, or
neither side.

1 In the Publishing tab, select the Page insert check box.

2 Select the option corresponding to your desired page arrangement.

3 To print on both the front and back of the inserted page, select the Print onto
front and Print onto back check boxes.
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Page Insertion Options

Check Box Selection Page Insertion Type
Page insert Inserts a blank page.

Page insert Prints on the front side of the inserted
page.Print onto front

Page insert Prints on the back side of the inserted
page.Print onto back

Prints on both sides of the insertedPage insert page.
Print onto front
Print onto back

Transparency Interleaving
Transparency interleaving inserts a backing sheet between printed
transparencies. The backing sheet, also known as an interleaf, helps keep
transparencies clean and prevents them from clinging together. This feature is
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only available when printing on transparencies supplied from the MP tray. You
can print the same content on the backing pages as on the transparencies.
Transparency interleaving cannot be used together with Cover mode or
Page insert.

Interleaving Transparencies

1 In the Basic tab, in the Media type list, select Transparency. If the Source and
Media type lists have been combined (by a selection in the Device Settings
tab, in the Compatibility Settings dialog box), Media type does not appear.
Instead, in the Source list select Auto (Transparency).

2 Click the Publishing tab.

3 In the Publishing tab, select the Transparency interleaving check box. To
print the transparency content on the inserted pages as well, select the Print
onto backing check box.

4 In the Media for backing list, select the Media type of the backing sheet or the
Source paper cassette. When you choose the Media type, the Source
cassette where that media is loaded is automatically selected.

5 Click OK to begin printing.

The printing system's operation panel prompts you to load transparencies into
the MP tray, and, if necessary, load backing paper into the selected cassette.
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In the Job tab, you can store print jobs in the memory installed in the printing
system. You can also select a Job name to use with Job storage features. You
can use this tab to set or change the default settings that apply when you print a
document from a Microsoft Windows application.
These features are available in the Job tab:
Temporary on page 9-2
Permanent on page 9-3
Virtual Mail Box on page 9-3
Quick Copy on page 9-4
Proof and Hold on page 9-5
Private Print on page 9-6
Job Storage on page 9-7
Job Name on page 9-9

Job Storage (e-MPS)
Job storage (e-MPS) offers a set of options for saving print jobs in printing
system memory, so that you can print or reprint them later. Print jobs can easily
be reprinted later using the printing system’s operation panel, and printing of
sensitive documents can be restricted to approved users. A portion of the
printing system's memory can be designated as a RAM disk for storing print job
data temporarily, or you can install a hard disk for larger capacity and
permanent storage.
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E-MPS is a multitier solution that provides advanced print management, directly
from the desktop. By storing a job in the printing system, you can print it from
the operation panel without sending it again from the computer.
To use the Job storage (e-MPS) features, you can set a User name in the
User Settings dialog box, available in the Device Settings tab.

Job Storage (e-MPS) options

Storage Access code When job is When job is Operation
location required printed deleted from panel e-MPS

memory location
Temporary Hard disk No When sent When hard disk None

from the is full and older
computer; it temporary jobs
can be have been
reprinted deleted

Permanent Hard disk No When sent When manually None
from the deleted
computer; it
can be
reprinted

Virtual mail Hard disk No When printed When printed e-MPS / Print
box from operation VMB Data

panel

Quick copy Hard disk No When sent When printing e-MPS / Quick
from the system is Copy
computer turned off or

hard disk is full

Proof and hold Hard disk or No One copy when When printing e-MPS / Quick
RAM disk job is sent; system is Copy

remaining turned off
copies later

Private print Hard disk or Yes When access When printing e-MPS /
RAM disk code is entered system is Private/Stored

at operation turned off or
panel after printing

Job storage Hard disk Optional When printed When manually e-MPS /
from operation deleted Private/Stored
panel

Temporary
Use Temporary to print jobs and save them on the hard disk. When the hard
disk becomes full, Temporary jobs are replaced beginning with the oldest jobs.
If you do not want jobs to be removed, select the Permanent option.
Selecting Temporary as a storage option increases print speed on a multiple
copy job. The first copy of the job is rendered once, then all subsequent copies
are printed at the rated speed of the printing system.
Temporary jobs can be reprinted by installing and using the Network Printer
Monitor utility.

Storing a Temporary Print Job
You can print a job and store it temporarily on the hard disk.
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1 In the Job tab, select Job storage (e-MPS).

2 Select Temporary.

3 Click OK in all dialog boxes.

Permanent
Use Permanent to print jobs and save them on the hard disk. Jobs are stored
on the hard disk until it becomes full, and then can only be removed manually.
Selecting Permanent as a storage option increases print speed on a multiple
copy job. The first copy of the job is rendered once, then all subsequent copies
are printed at the rated speed of the printing system.
A list of Permanent jobs can be printed at the printing system's operation panel.
Set a Job name and User name to help you find the jobs in the Permanent
Code Job List.
Permanent jobs can be reprinted by installing and using the Network Printer
Monitor utility.

Storing a Permanent Print Job
You can print a job and store it on the hard disk until it is removed manually.

1 In the Job tab, select Job storage (e-MPS).

2 Select Permanent.

3 Click OK in all dialog boxes.

Virtual Mail Box
Virtual mail box lets you send print jobs to electronic mail boxes rather than
physical mail boxes. Creating the Virtual mail box in the printer driver also
creates it on the hard disk. After jobs are sent to a Virtual mail box, they can be
printed from the printing system's operation panel. Jobs are saved until they are
printed and then are removed from memory. You can create up to 255 mail
boxes in the Hard Disk Settings dialog box in the Device Settings tab.

Storing a Job in a Virtual Mail Box
You can store a print job in a Virtual mail box where it is held for printing.

1 In the Job tab, select Job storage (e-MPS).

2 Select Virtual mail box (VMB), then click Selection.

3 Select a method for choosing an output tray:

Select one or more trays in the Defined names list.
Select Prompt for Mailbox ID. When you click OK in the Print dialog box,
select one or more trays from the Virtual Mailbox Selection dialog box that
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appears. If Virtual mail box is used repeatedly, this option lets you select
trays easily without opening the Job tab for every print job.

4 Click OK in all dialog boxes.

Printing Jobs from a Virtual Mail Box
You can print all accumulated jobs from a Virtual mail box.

1 At the printing system's operation panel, press the Print key.

2 Press the up or down key to select MENU, then press the OK key.

3 Press the up or down key to select e-MPS, then press the OK key.

4 Press the up or down key to select Print VMB Data, then press the OK key.

5 Press the up or down key to select the desired mailbox.

6 If prompted, use the numeric keypad to enter the five-digit access code.

7 Press the OK key to print.

Quick Copy
Quick copy is a Job storage (e-MPS) option that prints all copies of a print job
and stores the job temporarily on the hard disk for reprinting later. This feature is
available when a hard disk is installed and selected in the Device Settings tab.
Quick copy is useful for printing the job again later in the day when you need
additional copies at short notice. You can set the number of additional copies
and print the job from the printing system’s operation panel without sending the
job again from the computer.
The number of Quick copy or Proof and hold jobs that can be stored is set at
the printing system’s operation panel, to a maximum of 50 jobs. When the
designated number of jobs is reached, older jobs are replaced by new jobs. All
Quick copy jobs are stored on the hard disk after printing but are deleted when
the printing system is turned off. You can manually delete a job at the operation
panel.

Warning: A print job can replace a job on the hard disk having the same User
name and Job name. To prevent this, select Use job name + date and time
under Overwrite job name.

Printing a Quick Copy Job
With a hard disk installed, Quick copy lets you print a document and save it in
the printing system until the job is manually deleted or the printing system is
turned off.

1 In the Job tab, select Job storage (e-MPS).

2 Select Quick copy.
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3 Click OK in all dialog boxes.

For example, use Quick copy when you print copies for a meeting later in the
day. If you learn at the last minute that additional copies are needed, you can
print them quickly using the printing system's operation panel without sending
the job again from your computer.

Reprinting a Quick Copy Job
You can reprint a Quick copy job from the printing system’s operation panel
without sending the job again from your computer.

1 At the printing system's operation panel, press the Print key.

2 Press the up or down key to select MENU, then press the OK key.

3 Press the up or down key to select e-MPS, then press the OK key.

4 Press the up or down key to select Quick Copy, then press the OK key.

5 Press the up or down key to select the user name, then press the OK key.

6 Press the up and down key to select the job name, then press the OK key.

7 Use the numeric keypad to select the number of copies. You can select from 1
to 999 copies, or select Delete to delete the job.

8 Press the OK key.

Proof and Hold
Proof and hold is a Job storage (e-MPS) option that prints one copy of a print
job so that you can proof it before printing the remaining copies. This feature is
available when a hard disk is installed or a RAM disk is set up in the printing
system and selected in the Device Settings tab.
After the proof copy is printed and checked, remaining copies can be printed
from the printing system’s operation panel without sending the job again from
the computer. If desired, you can change the number of copies printed.

Note: Proof and hold is not available for some applications such as Microsoft
Excel.

The number of Proof and hold or Quick copy jobs that can be stored is set at
the printing system’s operation panel, to a maximum of 50 jobs. When the
designated number of jobs is reached, older jobs are replaced by new jobs. All
Proof and hold jobs are stored on the hard disk after printing but are deleted
when the printing system is turned off. You can manually delete a job at the
operation panel.

Warning: A print job can replace a job on the hard disk having the same User
name and Job name. To prevent this, select Use job name + date and time
under Overwrite job name.
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Printing a Proof and Hold Job
Proof and hold lets you print one copy of a multicopy job to proof before
printing the remaining copies. The job is stored on the hard disk or RAM disk
until the printing system is turned off or the job is manually deleted.

1 Click the Basic tab, and select the number of copies to be printed.

2 Click the Job tab and select Job storage (e-MPS).

3 Click Proof and hold, and click OK in both dialog boxes to print.

Printing the Remaining Proof and Hold Copies
After the proof copy has been reviewed, you can print the remaining copies from
the printing system’s operation panel without sending the job again from your
computer.

1 At the printing system's operation panel, press the Print key.

2 Press the up or down key to select MENU, then press the OK key.

3 Press the up or down key to select e-MPS, then press the OK key.

4 Press the up or down key to select Quick Copy, then press the OK key.

5 Press the up or down key to select the user name, then press the OK key.

6 Press the up and down key to select the job name, then press the OK key.

7 Use the numeric keypad to select the number of copies. You can select from 1
to 999 copies, or select Delete to delete the job.

8 Press the OK key.

Private Print
Private print jobs are saved on the hard disk or RAM disk for printing until a
four-digit Access code is entered. When the hard disk reaches maximum
capacity and a new job is sent to be stored, the oldest stored job is replaced by
the new job. Private print jobs are deleted when the printing system is reset or
turned off. If you do not want the job deleted, select the Job storage feature.
When sending a sensitive document to the printing system, a user must type a
four-digit Access code, which is attached to the print job along with the Job
name and User name. The job is not printed until a user enters the Access
code at the printing system’s operation panel. After the job is printed, it is
removed from printing system memory.
The number of Private print jobs that can be stored is limited only by the
storage capacity of the hard disk. You can manually delete a job at the
operation panel.
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Warning: A print job can replace a job on the hard disk or RAM disk having
the same User name and Job name. To prevent this, select Use job name +
date and time under Overwrite job name.

Storing a Private Print Job
Private print lets you store a document temporarily in printing system memory
without printing, and protect it with an Access code. The job is stored on the
Hard disk until it is printed or manually deleted. The job is stored in RAM disk
memory until it is printed or the printing system is turned off.

1 In the Job tab, select Job storage (e-MPS).

2 Select Private print.

3 In the Access code box, type four numbers if you want to restrict access to
your document.

4 Click OK.

Printing a Private Print Job
You can print a Private print job by entering the access code at the printing
system’s operation panel. The job is printed and immediately deleted from the
hard disk or RAM disk memory.

1 At the printing system's operation panel, press the Print key.

2 Press the up or down key to select MENU, then press the OK key.

3 Press the up or down key to select e-MPS, then press the OK key.

4 Press the up or down key to select Private/Stored, then press the OK key.

5 Press the up or down key to select the user name, then press the OK key.

6 Press the up and down key to select the job name, then press the OK key.

7 Use the numeric keypad to enter the access code, then press the OK key.

8 Use the numeric keypad to select the number of copies. You can select from 1
to 999 copies, or select Delete to delete the job.

9 Press the OK key.

Job Storage
Job storage is a Job storage (e-MPS) option that lets you store a print job
permanently on the hard disk for printing later. You also have the option of
protecting the print job from unauthorized printing by using an Access code.
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This feature is available when a hard disk is installed and selected in the Device
Settings tab.
Job storage is useful for jobs that need to be available for printing at any time,
even if the printing system has been turned off and turned on again. Job
storage jobs can only be removed manually from printing system memory.
If desired, you can attach a four-digit Access code to a Job storage job, so
that you can print a job without anyone else seeing it, or restrict printing to
approved users. When the access code is used, the job is not printed until a
user prints it at the printing system’s operation panel. After the job is printed, it
remains in printing system memory.
The number of Job storage jobs that can be stored is limited only by the
storage capacity of the hard disk. You can manually delete a job at the
operation panel.

Warning: A print job can replace a job on the hard disk having the same User
name and Job name. To prevent this, select Use job name + date and time
under Overwrite job name.

Storing a Job Storage Job
Job storage lets you store a document permanently in printing system memory
without printing, and gives you the option to protect it with an Access code.
This job remains on the hard disk until it is manually deleted.

1 In the Job tab, select Job storage (e-MPS).

2 Select Job storage.

3 If you want to restrict access to your document, select Access Code and type
four numbers in the box

4 Click OK in both dialog boxes to print.

Printing a Job Storage Job
You can print a Job storage job at the printing system’s operation panel. The
job remains stored for future printing on the hard disk.

1 At the printing system's operation panel, press the Print key.

2 Press the up or down key to select MENU, then press the OK key.

3 Press the up or down key to select e-MPS, then press the OK key.

4 Press the up or down key to select Private/Stored, then press the OK key.

5 Press the up or down key to select the user name, then press the OK key.

6 Press the up and down key to select the job name, then press the OK key.

7 If an access code was set, use the numeric keypad to enter the access code,
then press the OK key.
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8 Use the numeric keypad to select the number of copies. You can select from 1
to 999 copies, or select Delete to delete the job.

9 Press the OK key.

Job Name
A Job name is a unique identifier for each print job. It helps you find and print
your job from the printing system’s operation panel, or display the name on the
operation panel while printing. When you send a print job using one of the Job
storage (e-MPS) options, you can assign a custom name to the job or use the
name of the application file.
For Microsoft Word and PowerPoint, you can choose to include or omit the
application name from the application defined Job name. You can also ensure
that jobs in printing system memory are not replaced by new jobs having the
same Job name.

Don’t Use Application Name
Don’t use application name is an option to remove the application name from
the job name in the operation panel message and in job storage features. By
selecting Don't use application name, the file name you choose appears
clearly in the job list. This feature is applicable only when printing from Microsoft
Word or PowerPoint.

Overwrite Job Name
Overwrite job name is an option to ensure that a saved print job is not replaced
in printing system memory by a new job having the same Job name. If a user
sends two print jobs with the same User name and Job name, the second job
replaces the first job without any prompt. To prevent this, Overwrite job name
can automatically change the Job name by adding the date and time the job is
sent. This feature also helps you to track when print jobs were sent from the
computer.
The selected option applies to a Job name with either Application defined or
Custom selected. Overwrite job name options include:

Replace existing file
This option lets the current print job replace an existing job in printing system
memory, if a job with the same User name and Job name exists.
Use job name + date and time
This option adds the current date and time to the end of the Job name, in the
format: mmddyy hhmmss.

Selecting a Job Name
You must select a Job name to use with Job storage (e-MPS) features, so that
you can find your job in the job list displayed on the printing system’s operation
panel. The name can also be displayed on the operation panel while printing.
The selected Job name is saved with the print job when the job is sent to
printing system memory.

1 In the Job tab, select Job storage (e-MPS).

2 Under Job name, select a name:
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Application defined
This option uses the name of the application document as the Job name.
For Microsoft Word or PowerPoint documents, selecting Don’t use
application name removes the name of the application so that only the
document name appears as the Job name.
Custom
This option uses a unique name for each job. Type a name in the box, up to
79 characters.

3 Select an Overwrite job name option in case a job already exists in printing
system memory with the same Job name:

Replace existing file
If a job with the same User name and Job name exists, the current print job
replaces an existing job in printing system memory.
Use job name + date and time
Adds the current date and time to the end of the Job name, in the format:
mmddyy hhmmss
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In the Advanced tab, you can choose special features that extend the
capabilities of the printing system.
These features are available in the Advanced tab:
Prologue/Epilogue on page 10-1
Watermark on page 10-3
Security Watermark on page 10-5
Configuring Status Monitor on page 10-8
EMF Spooling on page 10-10
Enabling Client Profile on page 10-11

Prologue/Epilogue
The Prologue/Epilogue feature enables a user to insert a command file at the
beginning of a print job or at the end. The command file, prepared in a text
editor, utilizes programming commands from the printer resident PRESCRIBE
language. The Product Library CD includes a PRESCRIBE command
language reference guide. A command file is a set of instructions the printing
system interprets to produce a given output. For example, a
Prologue/Epilogue command file may contain a macro that places a graphic
object such as a logo at the top of a letterhead document.

Selecting a Prologue/Epilogue File
A Prologue/Epilogue file must be available on your system before it can be
added to a print job. To create this file, use a text editor like Windows Notepad.
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In the Prologue/Epilogue dialog box, select a Prologue/Epilogue file to insert
into the print job. (If no file names are visible in the list, you must click Add to
browse for files on your computer or network to add to the list.) After the file is
selected, insertion point options will be enabled.

Editing a Prologue/Epilogue File

1 In the Prologue/Epilogue dialog box, select a command file name from the list,
and then click Edit. Microsoft Notepad opens for editing the text file.

2 Make your changes to the file.

3 Save the file, and exit Microsoft Notepad.

Note: Editing and saving a command file overwrites the contents of the
existing local or network file.

Deleting a Prologue/Epilogue File

1 In the Prologue/Epilogue dialog box, select a Prologue/Epilogue file name
from the list, and then click Delete.

2 In the delete confirmation box, click Yes to accept.

Note: Only the file name is removed from the command file list. The file itself
is not deleted, but remains on the network or local computer.

Assigning a Prologue/Epilogue File

1 In the Prologue/Epilogue dialog box, select a Prologue/Epilogue file name
from the list.

2 Under Insertion Point, select a place to insert the Prologue/Epilogue file.

Unassigning a Prologue/Epilogue File
When you designate a Prologue/Epilogue file as unassigned, you are
removing it from the print job. It remains in the list. Unassigned selections are
useful when the list contains several Prologue/Epilogue files, and you want to
use some but not others.

1 In the Prologue/Epilogue dialog box, select a Prologue/Epilogue file name
from the list.

2 Under Insertion Point, select Unassigned.

Specifying the Insertion Point
The insertion point is the location in the print job where the selected
Prologue/Epilogue command file is processed by the printing system. Each file
in the list can be assigned only one insertion point.
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Note: The Start of the page and End of the page insertion point options are
available only when PCL 5e is selected as the Page Description Language
(PDL).

With a command file selected in the list, choose one insertion point option:
Unassigned
The selected command file is not inserted into the print job. This selection
can be used when you are working with multiple command files and want to
use some but not others. Select Unassigned for the command files you do
not want to use in the print job.
Beginning of the print job
The command file is inserted as the first page of the print job. The document
starts printing on the second page.
End of the print job
The command file is inserted as the last page of the print job, which prints
after the last page of the document.
Start of the page
The command file is inserted at the top of each page of the print job.
End of the page
The command file is inserted at the bottom of each page of the print job.
Only on odd pages
If Start of the page or End of the page is selected, this option can be
selected to insert the command file into all odd-numbered pages.
Only on even pages
If Start of the page or End of the page is selected, this option can be
selected to insert the command file into all even-numbered pages.
Pages
If Start of the page or End of the page is selected, this option can be
selected to insert the command file into specified pages. In the text box, type
individual page numbers separated by commas, or a page range separated
by a hyphen. For example, if you type 2 in the text box, the command file is
inserted only into page 2. If you type 1, 3, 5-12 the command file is inserted
into page 1, page 3, and pages 5 through 12. If the Pages option is selected
and you click OK without typing any numbers, you will be prompted to
specify page numbers.

Watermark
A watermark is a recognizable image or pattern that can be placed on a page or
throughout a document. You can choose one of the standard watermarks or
create your own text. The preview area at the left of the dialog box shows how
the watermark appears on a page. This is useful for making adjustments to the
appearance and location of the watermark.

Adding or Editing a Watermark
You can create a new watermark that displays your chosen text. Any watermark
can be edited, though a limited number of options can be changed for default
watermarks.

1 In the Advanced tab, click Watermark.
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2 In the Watermark dialog box, click Add to create a user defined watermark; or
under Select watermark, select a default or custom watermark and click Edit.

3 Under Watermark name, type a name, up to 39 characters. A default
watermark cannot be renamed.

4 Under Watermark text, type your preferred text. This option is not available
when editing a default watermark.

5 Select the desired font, style, and size of the text.

6 Select the color of the watermark from the list. The options available are black
and shades of gray.

7 Select the watermark Count, to a maximum of 20. In the Spacing spin box,
select the distance between two or more watermarks in tenths of an inch or in
millimeters.

8 Select the Position of the watermark with one of the following options.

Centered [default]
This option places the center of the watermark text in the center of the page.
User defined
This option lets you manipulate the x and y coordinate boxes to move the
text around the page.

You can also change the position by clicking the position button at the bottom of
the preview area. Click and hold as you drag the pointer to move the watermark
image.

9 Select the Angle of the watermark with one of the following options.

Diagonal [default]
This option places the watermark text at the default angle on the page.
User defined
This option lets you type a degree value for the angle. An angle is measured
in degrees, from 0 to 360.

You can also change the angle by clicking the angle button at the bottom of the
preview area. Click and hold as you drag the pointer to move the watermark
image.

10 The Rotate around center check box at the bottom far right of the dialog box
determines the method of rotation for the watermark. You must select User
defined in both Position and Angle to enable this option. Select Rotate
around center to position the watermark text with the center of the text as its
axis, and clear it to position the watermark text with the left end of the text as its
axis.

11 In all dialog boxes, click OK.
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Page Selection for Watermark
The Page Selection option for Watermark enables you to choose the location
for watermarks in your document.

1 In the Advanced tab, click Watermark.

2 In the Watermark dialog box, under Select watermark, choose a default or
custom watermark to print.

3 Under Page selection, choose pages for printing the watermark:

All pages
This option prints the watermark on each document page.
First page only
This option prints the watermark on the first document page.
All pages except first page
This option prints the watermark on all pages after the first page.
Only on specified pages
This option prints the watermark on page numbers typed in the box.
Print onto front outside cover
This option prints the watermark on the front cover. It is available when
Cover mode is selected in the Publishing tab. If Cover mode and Front
outside are both selected in the Publishing tab, Print onto front outside
cover is selected automatically.

4 In all dialog boxes, click OK.

Security Watermark
The Security Watermark is a plug-in feature that prints a nearly invisible image
or text against a background pattern. The security watermark appears only
when the printed page is photocopied. This helps to identify printed pages that
should not be photocopied, or to distinguish between original prints and
photocopies. Six standard security watermarks are available as text or image,
and you can create custom security watermark text.
A notable feature of Security Watermark is the Document guard pattern,
which prevents the document from being photocopied, scanned, faxed, or
printed from memory. If a scan, fax, or print from memory is attempted, the
process is stopped and an error message appears on the printer's operation
panel.
The Optional Printer Components wizard offers the opportunity to install the
Security Watermark plug-in following installation of the printer driver.
Security Watermark appears in the Advanced tab after selecting Device
Settings > PDL > Select PDL > PCL XL.
The administrator can ensure that a security watermark is printed on all jobs by
selecting Device Settings > Administrator > Lock Security Settings.
Selecting Security Watermark sets these driver features to the following
values:

Watermark in the Advanced tab is set to Off.
Resolution in the Imaging tab is set to 600 dpi.
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KIR in the Imaging tab is set to Off.
EcoPrint in Imaging > Quality is set to Off.
Adjustment Settings (Brightness and Contrast is set to 0) in Imaging >
Grayscale > Custom.

The reverse is also true. If these features are changed, then the Security
Watermark selection is set to None, and cannot be used.

Adding or Editing a Security Watermark
You can create a new security watermark that displays text but not an image.
Any security watermark can be edited, though a limited number of options can
be changed for default security watermarks.

1 In the Advanced tab, click Security Watermark.

2 In the Security Watermark dialog box, click Add, to create a new watermark; or
under Select security watermark, select a default or custom security
watermark and click Edit.

3 For Security watermark name, type a name up to 39 characters. A default
security watermark cannot be renamed.

4 For Security watermark text, type text or leave blank. This option is not
available when editing a default security watermark. Select from the following
options:

None
This option leaves the line blank.
User defined
This option inserts your text up to 39 characters.
All other options display date, time, or other job information that is obtained
from the computer or printer driver when the job is printed.

5 Select the desired font, size, style, and angle of the text.

6 Select Print as footer also if you want the first available line of watermark text
to be printed at the bottom of the page. Select the page position from the list.
This option is useful because the security watermark itself is not normally visible
on the printed page.

7 Under Background pattern, select a design for the security watermark
background.

Standard pattern
Select a design for the security watermark background. This option prints the
selected pattern with the watermark text or image.
Document guard pattern
The document guard design appears as the security watermark background.
This option prevents the printed page from being photocopied, scanned,
faxed, or printed from memory. If a photocopy is attempted, then gray copy is
produced. If a scan, fax or print from memory is attempted, the process is
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stopped and an error message appears on the printing system’s operation
panel.

8 Select Overprint for applications such as Microsoft PowerPoint and Internet
Explorer where the document content fills the entire page. The security
watermark is printed over the document data so that it can appear in a
photocopy. When editing an image, or if Device Settings > PDL Settings >
GDI compatible mode is selected, Overprint is selected automatically.

9 Adjust the calibration. After adjusting calibration, in all dialog boxes click OK.

Adjusting Security Watermark Calibration
For a security watermark to be effective, it must be nearly invisible in a printed
page and clearly visible in a photocopied page. Because printing systems and
driver settings can vary, you must adjust the calibration before printing a
security watermark. Adjusting the calibration is also recommended when
changing the background pattern, replacing the toner or printing system, and
after heavy printing activity.

1 After all security watermark options are selected in the Add Watermark or Edit
Watermark dialog box, click Adjust Calibration.

2 Under Pattern shading and Text contrast, select initial options:

Light, Normal, Dark
Select the shading density of the background pattern. When Document
guard pattern is selected in the Add Security Watermark or Edit Security
Watermark dialog box, this option is unavailable and set at Normal.
Contrast 1-9
Select the level of contrast against the background pattern, from lightest to
darkest.

These selections may need to be changed after printing a sample in the next
step.

3 Click Print Sample to print a page displaying all nine contrast options against
the selected pattern shading. It is recommended to print a sample page for each
pattern shading option.

4 From the Text Contrast Sheet, find the sample where the security watermark is
most nearly invisible.

5 In the Adjust Calibration dialog box, select options to match the sample
chosen in step 4.

6 In all dialog boxes, click OK.

Page Selection for Security Watermark
The Page selection options for security watermark determine where the
security the watermarks will be placed in the print job.

1 In the Advanced tab, click Security Watermark.
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2 In the Security Watermark dialog box, under Select security watermark,
choose a default or custom security watermark to print.

3 Under Page selection, choose pages for printing the security watermark:

All pages
This option prints the security watermark on each document page.
First page only
This option prints the security watermark on the first document page.
All pages except first page
This option prints the security watermark on all pages after the first page.
Only on specified pages
This option prints the security watermark on the page numbers typed in the
text box.
Print onto front outside cover
This option prints the security watermark on the front cover. This option is
available when Cover mode is selected in the Publishing tab. If Cover
mode and Front outside are both selected in the Publishing tab, Print
onto front outside cover is selected automatically.

4 In all dialog boxes, click OK.

Locking the Security Watermark Settings
The administrator can ensure that a security watermark is printed on all jobs by
locking the selected security watermark.

1 In the Advanced tab, select security watermark options and adjust the
calibration.

2 Select Device Settings > Administrator > Lock Security Settings.

3 In the Lock Security Settings dialog box, type a 4-16 character password, and
type again to confirm.

4 In all dialog boxes, click OK.

To unlock the security watermark, clear Lock Security Settings and type the
password.
To unlock the security watermark temporarily to change settings, in Advanced
> Security Watermark, click Unlock and type the password. After changing the
settings, the security watermark remains locked until it is unlocked in Device
Settings > Administrator Settings.

Configuring Status Monitor
The Status Monitor image displays printing system status messages in the
lower right corner of the window during printing. You can start a status monitor
for each supported printing system. More than one status monitor can be
displayed at one time.
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1 In the Advanced tab, click Status Monitor.

2 If you want the Status Monitor image to appear during a print job, in the Status
Monitor dialog box, select the Status Monitor check box.

3 To view the print job status without changing the Status Monitor setting, click
Open Status Monitor.
The Status Monitor image appears in the lower right corner of your computer
screen.

4 Move the pointer over the Status Monitor image to display balloon-style status
messages containing information about printing system activity and the printer
port.

5 To display a list of options, right-click the Status Monitor icon in the system
tray.

Hide the status monitor/Show the status monitor
Switch between hiding and showing the Status Monitor image.

Note: You can also hide the Status Monitor image by right-clicking on the
image, then clicking Hide the status monitor, or let the Status Monitor close
on its own after 5 minutes if there is no printing activity.

Configure
To open a web browser to display a printer Web page, click Configure.

Note: If your printer is connected with a USB cable, this feature cannot be
used. Define settings using the operation panel of the printing system.

Preferences
To open a dialog box with options for Status Monitor sound notification and
appearance choices, click Preferences.
Exit
To close the Status Monitor, click Exit.

Setting Status Monitor Preferences
You can configure printing system alerts with accompanying sound or speech in
the Status Monitor Preferences dialog box. You can also change the
appearance of the Status Monitor image.

1 Right-click the Status Monitor icon in the system tray.

2 Click Preferences.

3 Click the Sound Notification tab.

4 Click the Enables Event Notification check box.

5 Select an event for a Status Monitor alert.
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Cover open
Paper jam
Add paper
Sleep
Add toner
Toner low
Not connected
Printing
Printing completed

6 In the Sound Notification tab you can also add sound or speech to your
chosen alert.
To add a sound file:

Clear the Use Text to speech check box.
The sound file text box becomes available. Type the location of a sound file
(.wav), or browse to find a file located on your computer.

To add speech:
Select Use Text to speech.
Type your preferred text in the text box. The Microsoft Text to Speech utility
reads your typed text and plays it back in a spoken voice.

7 To change the size, placement, and transparency of the Status Monitor image,
click the Appearance tab.

Enlarge window
Select to double the size of the Status Monitor image and text balloons.
Always on top
Select to make the Status Monitor always appear on top of other open
windows.
Transparency
This option adjusts the Status Monitor to let a variable amount of
background show through the image. Type a value from zero to fifty in the
box. Higher values create greater transparency. A zero value creates a
completely opaque image.

8 In the Preferences dialog box, click Apply to save your settings, click OK to
save your settings and close the dialog box, or click Cancel to close the dialog
box without saving any settings.

EMF Spooling
EMF (Enhanced MetaFile) is a spool file format used in printing by the Microsoft
Windows operating system. When a print job is sent from an application, it is
transferred to the spool file. The application writes to and the printer driver reads
from the spool file simultaneously. For multiple or large documents, this quickly
returns application control to the user while the printer is still printing the
document.
To print with EMF spooling, in the Advanced tab select the EMF Spooling
check box. Continue the printing process as usual.
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Note: EMF spooling is not available when Allow data passthrough is
selected in the KPDL Settings dialog box.

Enabling Client Profile
Client profile refers to profile settings saved on a server and accessed by clients
in a client/server environment. This feature in the Advanced tab enables an
administrator to control and distribute profiles on a server. You would still have
the choice to use your local profiles or the server profiles. This function is
intended for use on the client side (PC side) in a client-server environment.

Clear the Enable client profile check box to select profiles from the server
to apply to print jobs created by the driver. Server profiles are read-only.
Select the Enable client profile check box for using custom profiles locally
in the driver.
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In Profiles, you can save printer driver settings as a profile. You can select
multiple options in the Quick Print tab and Printing Preferences, save them to
a profile, and use all of them at once when you apply the profile. A maximum of
26 profiles can be established in one driver, including the Factory Default
profile. Device options settings made in the Device Settings tab cannot be
saved to a profile.
These features are available in the Profiles dialog box:
Saving a Profile on page 11-2
Editing a Profile on page 11-2
Importing a Profile on page 11-3

Selecting Profiles
The Profiles dialog box always includes a Factory Default profile that returns
the driver options to their default settings. The profiles can include Common
Profiles, which are installed as optional components through the Printer
Installation Wizard, and any custom profiles created. Factory Default and
administrator profiles cannot be modified.

1 Click Profiles.

2 In the Profiles dialog box, select a profile.

3 Click Apply.

The side panel displays the options for that profile.

4 Click OK.
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Saving a Profile
The Save button lets you create your own profiles. You can select the printing
options you want in the driver, then save the driver settings including your
customizations as a profile. You can then use that profile to print the same type
of print job again without having to reselect all the settings. In Printing
Preferences, the Profiles button appears at the bottom of all the tabs.

1 Set the printing options you want for your print job by opening Printing
Preferences and selecting all your driver settings.

2 Click Profiles > Save.

3 To identify the profile, type a Name, select an Icon, and type a Description.

4 Click OK to save the profile.

The newly added profile appears in the Profiles dialog box.

5 Click Apply to activate the selected profile to the current print job, or click OK to
save the profile.

Note: To reset the printer driver to default settings, select the Factory Default
profile, and click Apply. This clears the settings of a selected profile.

Editing a Profile
The Edit button lets you make changes to an existing profile. The Factory
Default profile cannot be edited.

1 Click Profiles.

2 In the Select profile section, highlight the profile to be edited, and click Edit.

3 Any of the three options can be edited: name, icon and description. Click OK to
save the edited changes.
The newly edited profile appears in the Profiles dialog box.

4 Click Apply to activate the selected profile to the current print job, or click OK to
save the profile.

Deleting a Profile
The Delete button lets you remove an existing profile. The Factory Default
profile cannot be deleted.

1 Click Profiles.

2 In the Select profile section, highlight the profile to be deleted, and click
Delete.
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3 A message appears confirming the removal of the profile. Click Yes to remove.

4 Click OK to close the Profile dialog box.

Importing a Profile
The Import button lets you import a copy of a profile from other printer drivers
into your printer driver.

1 Click Profiles > Import.

2 Browse for the existing profile (.KXP), select it, and click Open.

A message appears if any of the profile settings in the imported file are not
available in the existing driver. Select Yes, to import the profile, or No, to cancel
the import.

3 If you selected Yes in the previous step, the newly imported file appears in the
Profile dialog box.

4 Click Apply to activate the selected profile to the current print job, or click OK to
save the profile.

Exporting a Profile
The Export button lets you export a copy of a profile from your printer driver for
use in other printer drivers. The Factory Default profile cannot be exported.

1 Click Profiles.

2 In the Select profile section, highlight the profile to be exported, and click
Export.

3 The Export Profile dialog box appears. Name and save the profile.

4 Click OK to close the Profiles dialog box.
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Glossary
A Access code A four-digit code that you must enter at the printing system’s

operation panel to print a Private Print job. An access code can also be used with the
Job storage feature.

Auto configure Device settings feature that queries a printing system through the
network and automatically retrieves settings for optional devices, memory, and RAM
disk. Driver settings will be updated with information received from the physical
printing system. Installed devices will be displayed in the Preview image.

B Booklet Layout feature that prints a multi-page document in a booklet format by
using a duplex unit. Two pages are printed on each side of a sheet to create a
document that can be read like a book.

C Cassette A removable plastic tray that holds a supply of paper for input to the
printer.

D dpi Dots per (linear) inch. Measurement that describes the sharpness and clarity of
printed text and images. The higher the dpi, the more detail there is in the printed
output.

E EcoPrint Imaging feature that changes toner saturation, making the entire image,
text and graphics, appear lighter in the printed job. The actual amount of toner used
depends on the printing system mode and the type of data printed (text, graphics, or
both). EcoPrint does not increase print speed. This feature is also available in the
Quick Print and Basic tabs

e-MPS Job storage (e-MPS) is a set of options for saving print jobs in printing
system memory, so that you can print or reprint them later. Print jobs can easily be
reprinted later from the printing system’s operation panel, and printing of sensitive
documents can be restricted to approved users.

Enable client profile Client profile refers to profile settings saved on a server and
accessed by clients in a client/server environment. This feature in the Advanced tab
enables an administrator to control and distribute profiles.

G GDI compatible mode A page description language option that accurately
reproduces what is viewed on the screen using the Microsoft Graphical Device
Interface (GDI) component to render the document. It generates data in a raster
printing format, creating a larger printable file.

Gutter Blank space on the left side or top of a printed page that can be increased
by scaling down text and graphics. This supports stapling and hole punching. When
used with Duplex printing, the enlarged blank space lines up evenly on both sides of
the sheet. The larger blank space is created by shifting the printable area to the right
or down as much as one inch (25.4 mm).
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H Halftone screen Imaging process that breaks down an image into dots. An
experienced user can adjust Halftone screen settings to create shades of gray in
graphic images. Larger dots spaced close together create darker shades, and smaller
dots spaced farther apart create lighter shades. Shading can be varied by adjusting
the number of rows of dots, the angle at which rows of dots are placed, and the shape
of the dots.

J Job accounting An accounting system that records and controls the number of
pages printed by each account ID. Account IDs can be assigned at the printing system
and stored in the driver. After account IDs are assigned, you can use the Job
accounting option to print in the Job accounting mode.

Job storage Job option that stores a print job permanently on a hard disk for
printing later. You also have the option of protecting the print job from unauthorized
printing by using an access code. This feature is available when a hard disk is installed
and selected in the Device Settings tab.

K KIR Imaging feature that smooths the edges of text and vector graphics.

M Media source enumeration A Device Settings option that maintains
compatibility for cassettes and feeders between old drivers and new drivers or when
moving from one manufacturer to another. Compatibility creates a smooth transition
for environments using macros or PRESCRIBE commands to access cassettes and
feeders.

MP tray Source tray used for labels, transparencies, envelopes, and custom
printing media.

O Optional Printer Components Optional Printer Components include Common
Profiles and Plug-In Modules, and need to be installed separately from the driver
installer. They are located on the Product Library CD in the Advanced Tools menu.

P PDF The Adobe portable document format (PDF) is independent of the application
software, hardware, and operating system used to create documents, and also of the
output device on which they are displayed or printed.

PDL Page Description Language. This is the language used by your computer to
tell the printing device how to print a document. Availability of some printing options
depends on the selected PDL.

Permanent job storage Job option that stores print jobs in the printing system’s
hard disk. Jobs stored on the hard disk can only be removed by manual deletion, so
are protected from being erased when the printing system is turned off or reset.

Plug-in An accessory program that integrates with the printer driver to enhance or
extend the driver's capabilities.

Poster Layout feature for printing a document in a larger size than the maximum
supported by the printer so the cumulative sheets can be assembled as a poster. Use
this feature to print a document in a large, eye-catching poster format, up to 25 times
larger than the original document size.
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PRESCRIBE An internal printer language that embeds commands into specified
locations in a print job.

Print graphics as black This option prints all color graphics and text with black,
rather than grayscale. This feature is intended for CAD applications.

Print text as black Prints all color text as black. It produces faster printing of color
print jobs by reducing the amount of data sent to the printer. In black and white
printing, it increases the detail for light-colored text printed. White text and image
colors are unaffected.

Private print Job option that saves print jobs on the hard disk for printing until a
four-digit access code is entered. Private print jobs are deleted when the printing
system is reset or turned off.

Profile A set of user defined driver settings that are saved as a group. Once saved,
you can select a profile by name and apply its settings to a print job without selecting
each feature individually.

Prologue/Epilogue Advanced feature that allows you to insert a macro into
specific locations in the print job. An advanced user may choose to use this feature to
embed a PRESCRIBE command that will call a macro to overlay PRESCRIBE form
data or a graphic object, such as a logo or a signature, at a specific point in the print
job.

Proof and hold Job option that prints one copy of a print job so that you can proof
it before printing the remaining copies. This feature is available when a hard disk is
installed and selected in the Device Settings tab. After the proof copy is printed and
checked, remaining copies can be printed from the printing system’s operation panel
without sending the job again from the computer.

Q Quick copy Job option that prints all copies of a print job and stores the job
temporarily on a hard disk for reprinting later. This feature is available when a hard
disk is installed and selected in the Device Settings tab.

Quick Print tab The Quick Print tab improves usability by providing an easier way
to set print options. You can choose basic settings or a predefined printer profile,
rather than having to go to various tabs. Quick Print settings can be captured in a
group called a profile. Profiles support common printing tasks, saving you from having
to repeatedly select the same settings. The Administrator can set the view of the Quick
Print tab through the Installation process, or Administrator Settings in Properties.

R RAM disk A feature that lets you set up an area within the printing system memory
as a virtual hard disk for faster printing. RAM disk is not an attached device, but an
allocation of existing printing system memory. RAM disk is temporary. All data sent to
RAM disk memory will be lost when the printing system is reset or turned off.

Resolution The number of dots printed in one inch. Higher resolution improves the
quality of detailed printed images.

S Security Watermark Plug-in feature that adds watermark text and a background
pattern to a print job. The text blends into the background pattern making it nearly
invisible when printed. The security watermark appears only when the printed page is
photocopied. A security watermark can be used to help protect against unauthorized
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reproduction of documents, or simply to differentiate original documents from
photocopies.

SNMP Simple Network Management Protocol. The standard TCP/IP protocol for
managing IP network devices, including printing devices. SNMP settings determine
the level of security when using the Auto Configure feature, and prevent unauthorized
printing to the SNMPv3 printing device. SNMP settings must be set in the
Administrator settings in the Device Settings tab, and in the printing system’s
Embedded Web Server.

Status monitor Optional feature that displays printing system status messages in
the lower right corner of the window during printing. You can customize the
appearance of the status monitor, and determine what messages are displayed and
how by selecting preferences and notifications.

T Temporary job storage Job option that stores print jobs on the printing system’s
hard disk. Jobs are removed from memory when the hard disk becomes full.

Transparency A clear plastic, page-sized sheet used as a printing medium.

Transparency interleaving Publishing feature that inserts a backing sheet
between printed transparencies. The backing sheet, also known as an interleaf, helps
keep transparencies clean and prevents them from clinging together.

V Virtual mail box Job options that sends print jobs to a choice of virtual output
trays, where they are sorted and stored in the hard disk rather than in physical
mailboxes attached to the printing system. Jobs accumulate in a numbered virtual
output tray until printed. To print, specify the virtual output tray number using the
printing system's operation panel. Virtual mail box print jobs are deleted after printing.
A total of 255 Virtual mail boxes can be assigned.

W Watermark The Watermark feature is available in the Advanced tab. A watermark
is a recognizable image or pattern that can be placed on a page or throughout a
document. You can choose one of the standard watermarks or create your own text.
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DIRECTIVE 2002/96/CE ON THE TREATMENT, COLLECTION, RECYCLING AND
DISPOSAL OF ELECTRIC AND ELECTRONIC DEVICES AND THEIR COMPONENTS

INFORMATION

1. FOR COUNTRIES IN THE EUROPEAN UNION (EU)

The disposal of electric and electronic devices as solid urban waste is strictly prohibited: it must be collected separately.

The dumping of these devices at unequipped and unauthorized places may have hazardous effects on health and the
environment.
Offenders will be subjected to the penalties and measures laid down by the law.

TO DISPOSE OF OUR DEVICES CORRECTLY:

a) Contact the Local Authorities, who will give you the practical information you need and the instructions for handling the
waste correctly, for example: location and times of the waste collection centres, etc.

b) When you purchase a new device of ours, give a used device similar to the one purchased to our dealer for disposal.

The crossed dustbin symbol on the device means that:

  - when it to be disposed of, the device is to be taken to the equipped waste collection centres and is to be
handled separately from urban waste;

  - The producer guarantees the activation of the treatment, collection, recycling and disposal procedures in 
accordance with Directive 2002/96/CE (and subsequent amendments).

2. FOR OTHER COUNTRIES (NOT IN THE EU)

The treatment, collection, recycling and disposal of electric and electronic devices will be carried out in accordance with the
laws in force in the country in question.
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